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JIAN Product Support 

 

JIAN Product Support Specialists can assist you with any problems related to installing or using 
the EmployeeFileBuilder product. 

Our phone number is 650-254-5600, extension 3. Support is available from 9:00 a.m. to 5:00 p.m. 
Pacific Time, Monday through Friday, excluding holidays. 

Before You Call 

1.  Please be sure that you followed the JIAN EmployeeFileBuilder installation instructions for 
your computer. 

2.  Almost all questions or problems can be resolved by using either the User's Guide or this on-
line help.  Please consult both of these resources BEFORE calling JIAN. 

3.  Double-check the "Frequently Asked Questions" in the User's  

Guide.  We may have already addressed your problem or question. 

When You Call 

Should you need support from JIAN to make the most effective use of JIAN 
EmployeeFileBuilder, please have the following information available when you call: 

1.  Your JIAN EmployeeFileBuilder serial number. This number is on the box, disk 1, or on the 
CD. 

2.  The make and model of your computer. 

3.  Your operating system software and version number (for example, Windows 95, Windows 
3.1). 

4.  A list of the error messages, if any, that you received when trying to install or open JIAN 
EmployeeFileBuilder files. 

Please be at your computer and ready to work with EmployeeFileBuilder.  Sometimes it may be 
necessary for you to leave a voice-mail message. If so, one of our Product Support Specialists 
will return your call as soon as possible. 

Hours: 9:00am to 5:00pm Pacific Time (Monday-Friday)  

Product Sales/Info: 1-800-346-JIAN (5426) 

Technical Support: 650-254-5600, extension 3 

Fax questions to: 650-254-5640 

Add More Users — $99.99 each 
Licenses for each additional concurrent user are $99.99 each - we issue additional serial #s.  

(You can use your existing manual & CD)  

To order an additional user license, please call: 

1-800-346-5426 x 7 or email us at 'sales@jian.com'  
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Overview of EmployeeFileBuilder 
 

From its inception, the design of EmployeeFileBuilder has been to provide the fastest, easiest, 
and most accurate way to track employees, corporate policies, benefits, time-off, and similar data.  
The information management capabilities provided are far beyond what can be accomplished 
with a traditional file system and corporate mail. 

The core of EmployeeFileBuilder is a database that provides intelligent reporting and analysis 
tools designed to work in new and innovative ways.  After initial data-entry, keeping all of your 
records up-to-date requires only minimal effort, and the program manages the rest.  The result is a 
large output of useful information in a practical graphical form, from just a few rules and raw 
day-to-day information. 

The great benefit about using EmployeeFileBuilder is that it applies your rules, such as 
limitations on late arrivals, vacations, benefits, and produces work force analyses in any form you 
choose with unlimited customized on-screen views and analysis reports.  Routine information 
entry for day-to-day work force management is only a few keystrokes (or ‘clicks’ of the mouse) 
away. 

File Folders 

Included with the powerful analytical capabilities of EmployeeFileBuilder are functions designed 
to incorporate all of your documentation needs in one on-line environment.  Each group of these 
functions is represented on the screen as one of the following file folders:  Employees, Corporate 

Views, and Corporate Policy.  Simply ‘click’ your mouse on one of the folder tabs, and start 
working in the area you wish. 

For example, the Employees folder contains personal information, performance & event 
documentation, location, job status, and a picture which you may import into the file. 

Button Bars 

Within each file folder, more detailed information may be obtained by selecting a topic from the 
button bar on the right side of the folder.  In the Employees folder, the buttons cover extended 
information such as benefits, notes, job & salary information, and other topics.  Once you have 
pressed one of these buttons, your screen displays the requested information just as if you had 
flipped a page in a file.  The highlighted folder at the top always indicates where you are, and 
changing from one folder to the next is easy with a ‘click’ of the mouse.  

While simple in design, EmployeeFileBuilder has been designed to provide the most powerful 
information processing with the least difficulty.  By using the Windows operating environment, 
we have been able to provide a strong product that is fast, productive, accurate, and above all, 
easy to use. 

Logging-on to EmployeeFileBuilder 

To logon to EmployeeFileBuilder, enter the correct User Code and User Password.  When the 
program is first installed, enter SUPER (Supervisor) for user name and leave the password field 
blank.  Make sure and set this password at a later time to prevent unauthorized access.  To add 
additional users to the system, first log in as SUPER and then from the Setup Menu select 
Security, Users.  The last User Code entered is automatically entered for you.  If you 
enter a different user code, that code will be automatically entered the next time you log 
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on. 

The Employee Code can also be entered for the User Code and that employee’s record will only 
be displayed.  This is helpful for letting individuals have access to their records without granting 
them access to the entire database.  To change the access restrictions for employees who login 
with their employee code, edit the security code of DEFAULT and set the Restrictions and 
Reports that general employees have access to. 

Click [Ok] or press ENTER to accept the User Code and User Password to open the database. 

Click [Cancel] or press ESC to cancel loading the database.  You can select options from the file 
menu if you need to compact, encrypt, repair, or Open another database. 

Welcome to EmployeeFileBuilder 

When EmployeeFileBuilder is started, the Welcome window is displayed. Click open existing 
database (EMPLOYEE) to open your database.  If you need to access the sample database, click 
Open the sample database (SAMPDATA).  Use this database to teach new users the product 
without the risk of working with live data. 

For network users: To set access to a shared database that may exist on a network drive: 

� Click [Close] 
� Select File, open, and select the database on a network. 
� Login as SUPER 
� Select Setup, Configure and enter the path and filename of the shared network 

database, then click [Save]. 

If you don’t want this dialog appearing every time the program is run, check the option ‘Do not 
show this window again’.  The next time the program is run, the existing database will be opened 
automatically and the login window will be displayed. 
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Update from version 3.2 
EmployeeFileBuilder 4.0 is a Win 98/2000/XP program.  Please be sure you have all of the latest 
Windows Service Packs installed... this makes world of difference!  

� Click the START button (on your desktop)  
� Click "Windows Updates" (or visit www.microsoft.com -- look for 'downloads')  
� Please follow the Microsoft instructions.  

Complete Your Import Before Adding Any Further Data 

The import will not change the data in the old database, but it will overwrite any/all information 
that exists in the new database (but it's empty so that's OK... unless you went ahead and typed 
stuff in it already--that stuff is gonzo in favor of upgrading all of your previous records from v3.2. 
Sorry.) Therefore, you should perform the import prior to adding new records or corporate 
policies. :-)  

During installation the Windows wants to default to creating a new subdirectory under "Program 
Files" called "JIAN EmployeeFileBuilder". You must change it to direct the new contents to be 
deposited into the EmployeeFileBuilder 3.2 folder. (Otherwise, to make ths work, you will need 
to drag your copy of EmployeeFileBuilder 3.2 into the new EFB4 folder. Either way works--as 
long as ALL of the content is together in the same folder...)  

To import your existing information open the new employee database and select "Import 
EmployeeFileBuilder 3.2 database" from the File, Add-ins menu.  
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More Software Tools to Build Your Business  

Agreement Builder 

Create legally binding agreements without starting from scratch. AgreementBuilder presents over 
100 business contracts in templates you can edit with any word processor. 

BizPlanBuilder 

BizPlan Builder is a proven, professional business plan software template you can use to 
convince investors to invest money in you company. Open, edit and print with any word 
processor and spreadsheet application.  

EmployeeManualMaker 

EmployeeManualMaker is a pre-written policy manual ready for editing and printing with your 
word processor. Covers over 140 policies and benefits. 

JIAN BusinessBasics 

JIAN BusinessBasics is a collection of 100 essential business tools to help with marketing, 
accounting, management, and personnel projects. Included are worksheets, agreements, 
spreadsheets, forms and checklists applicable to any business. 

Living Trust Builder 

Living Trust Builder contains software templates written by attorneys with more than 27 years 
experience in living trusts. Open with any word processor, edit and print.  

MarketingBuilder 

Create and track a powerful marketing campaign with ease! Just edit pre-written document 
templates with any word processor and spreadsheet. Covers Market Analysis, Marketing 
Communications and Sales Strategies. 

PublicityBuilder 

Create free promotion with this collection of 40% professional PR campaign software templates 
for press releases and company backgrounder. Includes in-depth PR know-how and tips from the 
press. 

SafetyPlan Builder 

Create a customized, OSHA-compliant safety plan fast with SafetyPlan Builder. Use menus to 
select your industry and state, and print. 

 

Visit www.jian.com or call JIAN at 1-800-346-5426 for more information and to place your 

order.   Thank you. 
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Menu: File Menu 
 

The File menu can be reached from any screen by pressing ALT-F.  In the File menu, you will 
find options to create, open, and close databases, data import and export, printing and printer 
setup, gateways to Microsoft Access and Crystal Reports, consolidation, add-ins, and the option 
to exit. 

� New 
� Open 
� Close 
� Import DataExport Data 
� Print 
� Print Setup... 
� Microsoft Access 
� Crystal Reports 
� Consolidate 
� Add-ins 

The following options are only available if the database is closed.  To access any of these options, 
first select Close from the File menu. 

� Backup Data 
� Compact Database 
� Encrypt Database 
� Repair Database 

File: New Database... 

To create a new database, select New database from the file menu.  The New Database window 
will appear.  Enter the directory name where the new database will be located.  Then enter the 
filename of the new database.  Check the option ‘Encrypt the database’ to make the database 
encrypted so that users outside of the program cannot use programs such as Norton DiskDoctor to 
view the contents of the file.  Check the option ‘Create an Access 1.1 version database’ if you 
have Microsoft Access version 1.1.  With this option unchecked, an Access 2.0 database is 
created. 

Click [Next >] and another page will be displayed verifying the information you entered.  If the 
information is not correct, click [< Back].  Otherwise, click [Finish] and the database will be 
created. 

After it has created the database, you have the option of opening the new database.  Click [Yes] to 
open the database and log in as ‘SUPER’ to start entering in new information. 

File: Open... 

To open a database, select a database from the file dialog box.  The default name of the employee 
database is EMPLOYEE.MDB. JIAN EmployeeFileBuilder also comes with a sample database, 
SAMPDATA.MDB for which you can open and experiment with the sample data.  This is highly 
recommended to get you familiar with the workings of EmployeeFileBuilder and to experiment 
with different configurations before you actually go on-line. 

Use this option to select between different databases or open a shared database on a network. 



EmployeeFileBuilder  User Manual 

10 

File: Close 

To close the current database, select Close from the File menu. 

Use this option if you need to: 

� BackupFILE_BACKUP, CompactFILE_COMPACT, EncryptFILE_ENCRYPT, or 
RepairFILE_REPAIR the database. 

� Re-Open the database so that a different user can log in. 
� Open a different database. 

File: Import Data 

When selected, this option will show a list of existing Import templates.  Select a template and 
then press [Import].  A dialog box showing the filename will be displayed.  Enter the filename 
for the file to be imported and click [Ok] to start the import.  Note: It is always recommended to 
perform a backup of your database before performing an import so that you may revert back to 
the original database in case of difficulty.  If the import file contains duplicates of the records in 
the EmployeeFileBuilder, there are two options to take care of this.  If you know that the records 
in the import file are duplicates and you wish to overwrite the existing records in the 
EmployeeFileBuilder database, check the option Replace duplicate records if they exist.  If this 
option is not checked, then any duplicate records will be prompted individually if you wish to 
overwrite them.  If you do not wish to replace the duplicates but want to import other records that 
are not duplicates, then check the option Import non-duplicate records.  This option will simply 
ignore all duplicate records and import non-duplicate records. 

If the import template you are looking for does not exist, or the import data exists on a different 
drive and/or directory, then you need to add or edit a template.  To create a new import template, 
click the [Add] button.  To edit an existing import template, double-click on the template in the 
list or click the template and then click the [Edit] button. The Add/Edit Templates dialog will be 
displayed.  Here, enter the name of the Template you wish to create.  Click on the Data File Type 
of the data you wish to import.  If the data is from another product, refer to the product’s 
documentation for help.  Select the filename of the import file.  Once a filename has been 
selected, match each Field in EmployeeFileBuilder with each field from the Import File.  Once all 
the fields have been assigned, click [Save] to save the template.   

File: Export Data 

When selected, this option will show a list of existing Export templates.  Select a template and 
then press [Export].  A dialog box showing the filename will be displayed.  Enter the filename 
for the file to be exported to and click [Ok] to start the export. 

To create a new export template, click the [Add] button.  To edit an existing export template, 
double-click on the template in the list or click the template and then click the [Edit] button. The 
Add/Edit Templates dialog will be displayed.  Here, enter the name of the Template you wish to 
create.  Select the filename of the export file, if the current file type is incorrect, click on the Data 
File Type of the data you wish to export and enter a filename.  Once a filename has been entered, 
match each Field in EmployeeFileBuilder with each field for the export File.  Once all the fields 
have been assigned, click [Save] to save the template.   

File: Backup Data 

Periodic backup of EmployeeFileBuilder data is strongly recommended.  This option executes 
any backup command that can be run from the command line; the default backup option uses the 
standard DOS backup.exe program.  Users of MS-DOS 6.0 or later that have MSbackup.exe in 
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place of the standard DOS backup.exe can either edit the command line in EmployeeFileBuilder, 
or set up a batch file in the DOS subdirectory called backup.bat that calls MSbackup.exe. 

Users of tape backup units, removable disks, or optical storage subsystems can replace the default 
command line in EmployeeFileBuilder with the command line necessary to run a backup 
procedure, or a batch file with the appropriate series of commands.  When this line is altered and 
run, that alteration becomes the default backup procedure.  If the backup procedure is consistent, 
the command line will not need to be changed for subsequent use. 

Note: This option is available only when you close the database.  For multi-user configurations, 
make sure that no other stations are accessing the EmployeeFileBuilder database before running 
the backup procedure. 

File: Print 

The print option on the file menu prints a report depending on the current view.  If the current 
view is the Main Form, the file print option prints the employee information report 
(EMPINFO.RPT).  The print dialog print dialog is displayed allowing you to select printer, 
screen, or file.  Other views, such as corporate views: Note Code Summary will print a bitmap of 
the current window to the printer. 

NOTE: If you want the current window to be captured and saved, use ALT-Print Screen to 
capture the current window to the clipboard.  Then Paste the image into your favorite paint 
program or word processor to be saved. 

Note: If the entire image does not print correctly, it may be caused by limited memory conditions.  
To solve this, exit other applications and try printing again. 

Example: 

To print all the times an employee was late in 1995, click Notes then click File, Print, click ‘Use 
Criteria’.  To select only late note codes: Click ‘EmployeeNotes.Code’ in the Available Fields 
list, click ‘Add ->’, in the criteria box, select ‘equal to’ from the drop-down list, then enter ‘L’ in 
the field to the right.  To select only notes in 1995, click ‘EmployeeNotes.StartDate’, click ‘Add -
>’, select ‘between’ and type ‘1/1/95’ in the box to the right and ‘12/31/95’ in the box below.  
Click Ok, then click Ok in the Print dialog to print the report. 

File: Print Setup 

When EmployeeFileBuilder is first loaded, all output will be directed to the default printer as 
defined in Control Panel.  To change the output to a Specific Printer or change options for the 
default printer, select Print Setup from the File menu.  A Print Setup dialog box will be 
displayed.  Refer to the Microsoft Windows Documentation for information on Printer Setup. 

File: Compact Database 

When using the EmployeeFileBuilder, Employee records may be deleted, pictures added and 
deleted, and other information may be removed.  To remove the deleted information and compact 
the database, select Compact Database from the File menu.  A dialog box will appear for 
verification.  Click [Yes] to compact the database or [No] to stop the operation. 

Database Compaction makes a duplicated copy of the database.  Because of this, you need to 
make sure there is enough disk space before proceeding with this operation. 

Note: This option is available only when you close the database.  For multi-user configurations, 
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make sure that no other stations are accessing the EmployeeFileBuilder database before running 
the backup procedure. 

File: Encrypt Database 

Encrypting the database uses a keyed coding method to help insure that data is not accessible 
outside the program's security system.  To encrypt the data, select Encrypt Database from the 
File menu.  For further information, consult the User's Guide or your system administrator. 

Database Encryption makes a duplicated copy of the database.  Because of this, you need to make 
sure there is enough disk space before proceeding with this operation. 

Note: This option is available only when you close the database.  For multi-user configurations, 
make sure that no other stations are accessing the EmployeeFileBuilder database before running 
the backup procedure. 

File: Repair Database 

Repairing the database should only be necessary if data problems arise when using the program.  
This option may be necessary to fix problems with data corruption that may have occurred due to 
a power failure, system lock up, or other hardware problem.  The most common cause of database 
corruption occurs when the user does not exit the program properly.  Remember to always exit 
the application by either selecting File and then Exit, or double-click on the control box in the 
upper left corner of the window.  To repair the employee database, select Repair Database from 
the File menu.  Using this option will restructure the database for proper, optimal performance. 

Note: This option is available only when you close the database.  For multi-user configurations, 
make sure that no other stations are accessing the EmployeeFileBuilder database before running 
the backup procedure. 

File: Microsoft Access 

If you wish to use Microsoft Access to do your own QBE (Query by Example), Reports, etc. that 
the EmployeeFileBuilder does not offer, select Microsoft Access from the File menu.  NOTE: 
Microsoft Access version 2.0 must be installed for this option to work.  Because 
EmployeeFileBuilder uses a secure database, Microsoft Access can only be run from the File 
menu, not from Program Manager.  This is to ensure that no users outside of the 
EmployeeFileBuilder program can get at sensitive information.  This option can also be disabled 
through EmployeeFileBuilder Security for users other than SUPER.  The default path for 
Microsoft Access is C:\ACCESS.  If Access is installed on a different drive and/or directory, 
change the pathname specified for Microsoft Access in the Configure dialog box. 

File: Crystal Reports 

If you wish to use Crystal Reports to create your own reports, that the EmployeeFileBuilder does 
not offer, select Crystal Reports from the File menu.  NOTE: Crystal Reports version 3.0 or 
greater must be installed for this option to work.  Because EmployeeFileBuilder uses a secure 
database, Crystal Reports can only be run from the File menu, not from Program Manager.  This 
is to ensure that no users outside of the EmployeeFileBuilder program can get at sensitive 
information.  This option can also be disabled through EmployeeFileBuilder Security for users 
other than SUPER.  The default path for Crystal Reports is C:\CRW.  If Crystal Reports is 
installed on a different drive and/or directory, change the pathname specified for Crystal Reports 
in the Configure dialog box. 

File: Add-ins... 
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The add-ins option on the file menu is used for quick access to external programs or utilities.  
When the file, add-ins option is selected, a menu will appear to the right with each add-in listed as 
a menu option.  The last option, Add-in Manager, is used to add new add-ins to the system. 

Add-in Manager 

The add-in manager is used to add new add-in programs to the add-ins menu.  To add a new add-
in to the system, click [Add] and enter a description of the add-in, next, enter the filename and 
path of the executable.  Click [Browse] to find the program on your hard disk. 

To add a program such as the Windows calculator, click [Add], enter ‘Calculator’ under 
description, enter ‘C:\WINDOWS\CALC.EXE’ for the filename, and click [Save].  Click [Close], 
click File, Add-ins, Calculator, and the calculator will be displayed. 

Use [Retrieve] button to retrieve add-ins supplied on diskette.  These programs may be offered 
from Paradigm or other sources to enhance EmployeeFileBuilder. 

File: Consolidate 

The Consolidation option from the File menu gives you the ability to manage multiple sites.  If 
you have one central office that does data processing, each remote location can Output their 
employee information to a file where it can be transported via diskette, WAN, Modem, etc. to a 
central location for Input into a single database. If you are receiving a file from another location, 
select Input.  The Input option will bring in all employee records, any existing employees are 
overwritten..  To output employees to another site, use Output.  This option gives you a dialog 
which you can enter a start date and an end date.  Then select a filename- this must be a MS 
Access (*.MDB) file.  The dates tell the system how much history to include with each employee.  
If you routinely consolidate once every quarter, the central office will already have history for 
employees since the previous quarter.  In this case, just click the [Quarter] button to only send 
Notes, Performance, Corporate Mail, and Memos for the previous quarter only. 

Menu: Edit Menu 

The Edit menu consists of two parts.  The first items separated by a bar duplicate the 
functionality of the buttons along the bottom of the window.  If the Main Form is displayed, the 
buttons are displayed as [Add], [Edit], [Delete], [Location], and [Picture].  The first half of the 
edit menu displays the same options. 

The last three options select what records are displayed, how they are sorted, and give the option 
to refresh in case records have been added in a multi-user environment and need to be re-sorted. 

These options are: 

 Set Filter 

 Record Sort Order 

 Refresh 

Edit: Set Filter 

The Set Filter option on the Edit menu allows you to show only the records you want to see.  For 
instance, you may only want to view full-time employees in engineering. When a filter is created, 
only the records which match the selected criteria are displayed in the employee folder, corp. 
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views, and reports. 

Edit Filter 

To restrict the records displayed in the system, click Edit, Set Filter.  Select the fields along with 
the criteria in this window and click [Ok] when done.  Use the criteria window to ‘build’ a 
formula such as ‘EmployeeStatus is equal to ‘FULLTIME’. 

To build criteria, do the following steps: 

Select the field.  From the list of Available Fields, click the field in the list.   

Click [Add ->] to add the field to the list on the right; ‘Filter on these fields:’. 

Below, a box displays two drop-down lists.  The first drop-down selects ‘is’ or ‘is not’. 

The next drop-down list selects how the comparison is to be done. ‘any value.’, ‘equal to’, ‘less 
than’, ‘less than or equal to’, ‘greater than’, ‘greater than or equal to’, ‘between’, and ‘one of’. 

A new drop-down will appear to the right allowing you to enter criteria.  Click the drop-down 
arrow to select from the actual data in the database.  If the ‘between’ option is selected, two drop-
down boxes will appear allowing for a starting and an ending value to be entered.  This option is 
preferable when you need to select a range of values.  Example: all notes last year would be 
‘EmployeeNotes.StartDate’ is between ‘1/1/95’ and ‘12/31/95’.  The last option ‘one of’ is very 
useful when you need to select mutiple values at the same time.  Example: all vacation and sick 
notes would be ‘EmployeeNotes.NoteCode’ is one of ‘V’, ‘S’.  It would be incorrect to do the 
following: EmployeeNotes.NoteCode is equal to ‘V’ and EmployeeNotes.NoteCode is equal to 
‘S’ because one note code record can’t be both V and S. 

Click [Ok] when done 

Example: To build a filter to show only full-time employees in engineering, click edit, set filter, 
select field ‘Employees.EmployeeStatus’, click [Add ->], select ‘is’, ‘equal to’, type 
‘FULLTIME’, then select field ‘Employees.Department’, click [Add ->], select ‘is’, ‘equal to’, 
type ‘Engineering’, then click [Ok]. 

Note: the location fields, Branch, Department, Area, and Team, may not be editable. This will 
happen if you are restricted to a specific location defined in Setup, Security, Users.  If, for 
example, your user code has a location set to: Branch: Seattle, Department: Sales, you can only 
view employees in Seattle, Sales.  The Branch and Department fields will already appear in the 
fields list but cannot be changed.  The resulting report will only print employees in Seattle, Sales. 

Edit: Record Sort Order 

To change the order of the records displayed in the employee folder, select ‘Record Sort Order…’ 
from the edit menu.  The Set Record Sort Order dialog will be displayed. 

Set Record Sort Order 

The order of the records displayed in the employee folder can be set by selecting Edit, Record 
Sort Order.  Up to five fields can be selected and set to either ascending or descending order. 

Example: Order the records in the employee folder by Employee Status, then by Last name, and 
First Name.  Select the first field ‘EmployeeStatus’, then the next field ‘LastName’, then the next 
field ‘FirstName’ then click [Ok]. 
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Edit: Refresh 

The refresh option on the edit menu refreshes the data displayed in the employee folder.  If you 
have added a lot of records or are in a multi-user environment where other people are adding and 
changing records, click Refresh to bring your displayed information up to date. 

Menu: Goto Menu 

Use the goto menu to move around in the database or in the program.  

The first section of the goto menu includes options that will allow you to jump or browse through 
employee data.  Choosing ‘Next’ brings you to the employee that immediately follows the one 
you are currently viewing, while choosing ‘Previous’ displays the record just before the current 
employee.  Select ‘First’ to go to the first employee listed in your database.  To see the employee 
at the very end of the list, select ‘Last’. 

To Find a specific employee, click ‘Find’. 

To go to a different Location, click ‘Location’. 

To go to a different part of the program without using the mouse, click ‘Page’. 

Goto Find 

To find an employee, select the Find option from the goto menu. 

Find 

The find option can be a very useful tool when you need to locate specific employees.  For 
example, if you need to find Michael Smith but didn’t remember his first name, click Goto Find, 
enter Smith, select field ‘LastName’ and click ‘Find’.  A list of all the ‘Smiths’ are listed.  Click 
the one you want and click [Goto]. 

Use the match drop-down to select partial searches.  A partial search could be that you remember 
that the last name starts with ‘Peter’ but didn’t know the exact spelling.  Enter ‘Peter’, select 
LastName, and select ‘Start of Field’ and click Find.  The list then will show a ‘Peterson’ which 
is the person you were looking for. 

The find option can also be useful for quick queries of the data.  For instance, you want to list all 
FULLTIME employees.  Enter ‘FULLTIME’, select ‘EmployeeStatus’, and click ‘Find’.  All 
full-time employees are then listed. 

Goto Location 

Each employee has a location specified by Branch, Department, Area, and Team.  The current 
location can be set by selecting the Goto Menu then selecting Location from any folder, or by 
pressing F2. 

A tree view is displayed as defined in the Organization Chart.  Click the location in the chart you 
wish to go to, and click [Ok].  The records are filtered based on the new location.  If a location 
selected has no employees, you will see only the [Add] button enabled.  The top of the window 
shows the current location that you are at and the New location displays the selected location in 
the list. 

Note: if you are restricted to certain locations in security, only the locations you are able to see 
are displayed. 
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Define the location for the User in Setup, Security, Users. 

Goto Page 

To move within the program without using the mouse, click goto, page.  A list is displayed with 
each folder and the pages it contains.  Click the page to go to and click [Ok]. 

Menu: View Menu 

While the Goto menu can be used to select employees and jump between folders, The View 
menu can be used to display a list of all employees (or all employees in the currently selected 
location), or display a calendar. 

Click the Status bar option to turn the status bar on and off.  Use this in case you would like to 
gain space on the screen that the status bar takes up. 

To display a list of employees, choose Employee List from the View menu. 

To display a calendar, choose Calendar from the View menu. 

View Menu: Employee List 

The employee list option provides for a quick way to display a list of all the employees in the 
current location.  To show the employee list, select Employee List from the View menu.  To go 
to an employee in the list, click the employee, then click [Select], or Double-Click on the 
employee, and the employee record will be displayed in the Employees Folder.  If selected while 
in another folder, this option will cause the active folder to change to Employees, and the selected 
employee's record to be brought to the front. 

View Menu: Calendar 

To display a calendar, select Calendar from the View menu.  The calendar will display the 
current month with today selected.  Press PageUp or click the left arrow to go back one month, 
PageDown or right arrow to go forward one month, Ctrl-PageUp to go back one year, and Ctrl-

PageDown to go forward one year. 

 

When editing date fields, press F8 to display the calendar, or press the Calendar icon to the right 
of the field.  Select the new date by clicking the day. 

View Clock 

To select the time from the clock, click the clock icon next to a time field.  Click the up and down 
arrow buttons next to the hour and minute fields to adjust the time and click [Ok] when done. 

Popups 

This list is a user definable list of codes or descriptions for the current field.  To select an item 
from the list, click the item and click [Select] or double-click the item.  To add new items to the 
list, first click [Modify >>] then click [Add].  To edit an item in the list, click [Modify >>], then 
click [Edit].  To delete an item from the list, click [Modify >>] then click [Delete]. 
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Reports 
 

All the reports contained within JIAN EmployeeFileBuilder are arranged by group and 
description.  Each group is displayed as an option within the Reports menu.  Each report within 
the group is displayed as a list.  Click on a group to show a list of reports within that group.  To 
select a report, click on the report and then click [Select] or double-click on the report.  The Print 
dialog box will appear.   

The Custom Reports option allows for the adding of new reports created with Crystal Reports. 

Printing a Report 

The Print dialog box is used to select how many copies, the destination, and the criteria for the 
report to be printed.  Each option is explained as follows: 

Copies 

Enter the number of copies you want to print or use the spin control to increase or decrease the 
number of copies to print.  When first displayed, the number of copies defaults to 1. 

Print to 

Printer: This option sends the report to the default printer as defined in the Print Setup dialog box.  
If you wish to change the default printer, select the [Setup...] button. 

Screen: This option displays the report on the screen.  When the report is displayed, you can 
scroll the report using the scroll bars to the left and along the bottom of the window.  Use the 
arrow buttons on the lower left to jump to the next, previous, first, or last pages of the report.  If 
the report has many pages and you wish to cancel, press the Cancel button to stop.  Note: when 
this is done, not all pages of the report are processed.  Use the Magnifying glass button to display 
the report in different sizes in the window.  The printer icon displays a Print dialog which allows 
you to enter a range of pages to print.  Click [Ok] to print the selected pages to the default printer.  
Use the Suitcase Icon to export the report to many different formats.  Select the format and the 
destination then click [Ok] to export the information.  Click the Envelope with paperclip button 
to export and send the report to Mail.  Select the format and the destination then click [Ok] to 
send the report to another user.  Click [Close] or press Ctrl-F4 to close the report window.   

File: This option exports the report data to a file. Enter the filename and then select the output 
format from one of the following formats: Record Format, Tab Separated, Text Format, DIF 
Format, or Comma Separated. 

Use Criteria 

When this option is selected, the report is filtered depending on criteria that you specify.  Click 
the [Edit Criteria...] button to edit the Report Criteria.   

Options 

Click the Options button to change options for the report to be printed such as pages to be printed, 
print date, custom page margins, and sorting. 
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Reports: Print Options 

The Print Options dialog box is used to customize how the report is to be printed.  The Start 

Page and Stop Page options set what pages of a multi-page report are to be printed.  This is 
helpful if a long report was interrupted during printing.  Enter the start page of the report to start 
printing and the end page.  Enter a -1 for the end page to print to the last page. 

Use the Print Date option to specify a date for the report to be printed.  Some reports are date 
sensitive and must be run on the day they are reporting for.  If you need to run a report for a date 
in the past, enter the Year, Month, and Day of the past date and the report will run as if that date 
is today’s date. 

The Margins settings are used to specify margins for a report that may be printed on odd-sized 
paper, or for a printer that may be cutting off some information because of a non-printable area.  
Enter the Top, Left, Bottom, and Right margins of the report in inches.  All are set to 0 which sets 
the report to its own designed margins, usually .25” for all borders. 

 

Note: if you have to change the margins constantly, you may want to use Crystal Reports to 
change the margins on the reports themselves to work with your specific printer. 

Sorting 

The sorting option allows you to specify sort fields other than what was originally designed in the 
report.  Any sorting specified here will override any sorting defined within the report.  If you 
want a report always sorted by something other than the report’s original design, it is best to 
customize the report itself using Crystal Reports.  You can specify up to two fields for sorting, a 
primary, and a secondary sort field.  Select the field from the drop-down list and select whether 
you want it ascending or descending order.  Example: if you want the Address list to be sorted by 
city, select Options, Primary: City, and Ascending and click [Ok].  Note: the sorting will only be 
based on the fields in the first table specified for the report in the Edit Report window. 

Reports: Edit Criteria 

The Report Criteria dialog box displays the fields and comparisons entered for the current report 
selected.   

Use the criteria window to ‘build’ a formula such as ‘EmployeeStatus is equal to ‘FULLTIME’. 

To build criteria, do the following steps: 

Select the field.  From the list of Available Fields, click the field in the list.   

Click [Add ->] to add the field to the list on the right; ‘Filter on these fields:’. 

Below, a box displays two drop-down lists.  The first drop-down selects ‘is’ or ‘is not’. 

The next drop-down list selects how the comparison is to be done. ‘any value.’, ‘equal to’, ‘less 
than’, ‘less than or equal to’, ‘greater than’, ‘greater than or equal to’, ‘between’, and ‘one of’. 

A new drop-down will appear to the right allowing you to enter criteria.  Click the drop-down 
arrow to select from the actual data in the database.  If the ‘between’ option is selected, two drop-
down boxes will appear allowing for a starting and an ending value to be entered.  This option is 
preferable when you need to select a range of values.  Example: all notes last year would be 
‘EmployeeNotes.StartDate’ is between ‘1/1/95’ and ‘12/31/95’.  The last option ‘one of’ is very 
useful when you need to select mutiple values at the same time.  Example: all vacation and sick 
notes would be ‘EmployeeNotes.NoteCode’ is one of ‘V’, ‘S’.  It would be incorrect to do the 
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following: EmployeeNotes.NoteCode is equal to ‘V’ and EmployeeNotes.NoteCode is equal to 
‘S’ because one note code record can’t be both V and S. 

Click [Ok] when done 

Example: To build a filter to show only full-time employees in engineering, click edit, set filter, 
select field ‘Employees.EmployeeStatus’, click [Add ->], select ‘is’, ‘equal to’, type 
‘FULLTIME’, then select field ‘Employees.Department’, click [Add ->], select ‘is’, ‘equal to’, 
type ‘Engineering’, then click [Ok]. 

Click the [Ok] button to close this dialog window.  This criteria is used only when the Use 

Criteria option is selected in the Print dialog box. 

Note: the location fields, Branch, Department, Area, and Team, may not be editable. This will 
happen if you are restricted to a specific location defined in Setup, Security, Users.  If, for 
example, your user code has a location set to: Branch: Seattle, Department: Sales, you can only 
view employees in Seattle, Sales.  The Branch and Department fields will already appear in the 
fields list but cannot be changed.  The resulting report will only print employees in Seattle, Sales. 

Reports Menu: Custom Reports 

EmployeeFileBuilder uses report files compatible with Crystal Report Generator, and additional 
reports can be added by users with the full version of Crystal Reports or from add-on packages of 
reports (contact your local reseller or Paradigm Software for more information). 

Add the new report to the list of reports in the system.  Click the [Add] button and the Add 
Report dialog will be displayed.  To edit a report already in the system to change the path, tables, 
and customize options for a report click the [Edit] button and the Edit Report dialog will be 
displayed.  Click [Delete] to remove a report from the system. 

If you have a purchased set of reports and wish to add them to your system, click the [Retrieve...] 
button to Retrieve Reports from diskette. 

Add Report Wizard 

The add report window is used to add a new report into the system.  First enter the full path and 
filename of the report.  Click [Browse…] to search for the report on your hard drive.  Once the 
report filename has been entered, click [Next ->].  The next page asks to select a group to add the 
report to.  Click the down arrow and select an existing group.  If you wish to create a new group, 
which appears in the Reports menu, type in the new name of the group.  Next enter a description 
of the report.  The description is what appears when the list of reports is displayed.  Check the 
option ‘Allow users to select criteria for the Report’ if you want users to select criteria for their 
own reports.  A report may be designed to look at specific information and already has criteria 
designed for it so this option may be left unchecked.  Other reports such as address lists, may 
allow for users to select what employees to list. 

Click [Next ->] and the next page will display the information entered for you to verify before 
adding the report to the system.  If everything is correct, click [Finish]. 

Retrieve Reports 

To retrieve reports from diskette, insert the disk into A: or B:.  Select the drive from the drives 
prompt.  The list of reports will be retrieved from the diskette and displayed as a list.  Click each 
report that you wish to retrieve or click [Select All] to select all the reports.  Click [Ok] to start 
the retrieval process.  All the reports will be copied onto your hard disk and added to your menu 
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automatically.  Note: after reports have been retrieved, you may need to set Security Codes and 
Levels for each security code (except SUPER) to allow access of these reports to other users. 

Edit Report 

This option enables you to add reports that can be pre-defined or designed by yourself with the 
Crystal Reports package.  Use the Crystal Reports option from the File Menu and you can create 
your own reports or modify existing ones.  Once the report has been saved, it can be added to the 
reports currently installed in EmployeeFileBuilder. 

Enter the group name of the report.  You can enter a new group name and the new group will be 
displayed as an item in the report menu.   

Enter the name for the report.  This name will be displayed in the list of reports selected.  Give it 
a descriptive name such as 'Employees sorted by Department'.  Enter the filename of the report as 
saved in Crystal Reports.  Include the pathname of the report only if the report is not in the 
directory specified for reports in the Configure option of the setup menu.   

Select the tables used in the report.  At least one table is required for the user to be able to select 
criteria for the report.  The Use Criteria option in the Print Dialog box uses field names from the 
tables that are defined for the report.  For example: If the report created lists Employees and the 
Notes for each employee, then the tables will be Employees and Employee Notes.  This makes it 
so the criteria can be selected from any field in the Employees table and the Employee Notes 
table.  Custom sort options will use the first table only.   

Click on the Allow Criteria option if you want users to be able to enter criteria for the report.  
For instance, the Company Information report does not require criteria because the report is only 
for one set of information. 

If you have the Crystal Reports package and wish to edit the actual report definition, click [Edit 

Report...] and the Crystal Reports package will be loaded with the report displayed on screen.  
Modify the report, then save it, and then exit Crystal Reports.  Run the report from within 
EmployeeFileBuilder to test the results. 
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Graphs 
 

All the graphs contained within JIAN EmployeeFileBuilder are arranged by group and 
description.  Each group is displayed as an option within the Graphs menu.  Each graph within 
the group is displayed as a list.  Click on a group to show a list of graphs within that group.  To 
select a graph, click on the graph and then click [Select] or double-click on the graph.  The Print 
dialog box will appear.   

The Custom Graphs option allows for the adding of new graphs created with Crystal Reports. 

Printing a Graph 

The Print dialog box is used to select how many copies, the destination, and the criteria for the 
graph to be printed.  Each option is explained as follows: 

Copies 

Enter the number of copies you want to print or use the spin control to increase or decrease the 
number of copies to print.  When first displayed, the number of copies defaults to 1. 

Print to 

Printer: This option sends the graph to the default printer as defined in the Print Setup dialog box.  
If you wish to change the default printer, select the [Setup...] button. 

Screen: (default) This option displays the graph on the screen.  When the graph is displayed, you 
can scroll the report using the scroll bars to the left and along the bottom of the window.  The 
printer icon displays a Print dialog which allows you to enter a range of pages to print.  Click 
[Ok] to print the selected pages to the default printer.  Use the Suitcase Icon to export the report 
to many different formats.  Select the format and the destination then click [Ok] to export the 
information.  Click the Envelope with paperclip button to export and send the graph to Mail.  
Select the format and the destination then click [Ok] to send the graph to another user.  Click 
[Close] or press Ctrl-F4 to close the report window.   

File: This option exports the graph data to a file. Enter the filename and then select the output 
format from one of the following formats: Record Format, Tab Separated, Text Format, DIF 
Format, or Comma Separated. 

Use Criteria 

When this option is selected, the graph is filtered depending on criteria that you specify.   

Click the [Edit Criteria...] button to edit the Graph Criteria.   

Options 

Click the Options button to change options for the graph to be printed such as pages to be printed, 
print date, custom page margins, and sorting. 

Graphs: Print Options 

The Print Options dialog box is used to customize how the graph is to be printed.  The Start 
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Page and Stop Page options set what pages of a multi-page report are to be printed.  This is 
helpful if a long report was interrupted during printing.  Enter the start page of the report to start 
printing and the end page.  Enter a -1 for the end page to print to the last page.  Note: normally 
you won’t have to set these because graphs normally fit on one page. 

Use the Print Date option to specify a date for the graph to be printed.  Some graphs are date 
sensitive and must be run on the day they are reporting for.  If you need to run a graph for a date 
in the past, enter the Year, Month, and Day of the past date and the graph will run as if that date is 
today’s date. 

The Margins settings are used to specify margins for a graph that may be printed on odd-sized 
paper, or for a printer that may be cutting off some information because of a non-printable area.  
Enter the Top, Left, Bottom, and Right margins of the graph in inches.  All are set to 0 which sets 
the report to its own designed margins, usually .25” for all borders. 

Note: if you have to change the margins constantly, you may want to use Crystal Reports to 
change the margins on the graphs themselves to work with your specific printer. 

Sorting 

The sorting option allows you to specify sort fields other than what was originally designed in the 
report.  Any sorting specified here will override any sorting defined within the report.  If you 
want a report always sorted by something other than the report’s original design, it is best to 
customize the report itself using Crystal Reports.  You can specify up to two fields for sorting, a 
primary, and a secondary sort field.  Select the field from the drop-down list and select whether 
you want it ascending or descending order.  Example: if you want the Address list to be sorted by 
city, select Options, Primary: City, and Ascending and click [Ok].  Note: the sorting will only be 
based on the fields in the first table specified for the report in the Edit Graph window. 

Graphs: Edit Criteria 

The Graph Criteria dialog box displays the fields and comparisons entered for the current graph 
selected. 

Use the criteria window to ‘build’ a formula such as ‘EmployeeStatus is equal to ‘FULLTIME’. 

To build criteria, do the following steps: 

Select the field.  From the list of Available Fields, click the field in the list.   

Click [Add ->] to add the field to the list on the right; ‘Filter on these fields:’. 

Below, a box displays two drop-down lists.  The first drop-down selects ‘is’ or ‘is not’. 

The next drop-down list selects how the comparison is to be done. ‘any value.’, ‘equal to’, ‘less 
than’, ‘less than or equal to’, ‘greater than’, ‘greater than or equal to’, ‘between’, and ‘one of’. 

A new drop-down will appear to the right allowing you to enter criteria.  Click the drop-down 
arrow to select from the actual data in the database.  If the ‘between’ option is selected, two drop-
down boxes will appear allowing for a starting and an ending value to be entered.  This option is 
preferable when you need to select a range of values.  Example: all notes last year would be 
‘EmployeeNotes.StartDate’ is between ‘1/1/95’ and ‘12/31/95’.  The last option ‘one of’ is very 
useful when you need to select mutiple values at the same time.  Example: all vacation and sick 
notes would be ‘EmployeeNotes.NoteCode’ is one of ‘V’, ‘S’.  It would be incorrect to do the 
following: EmployeeNotes.NoteCode is equal to ‘V’ and EmployeeNotes.NoteCode is equal to 
‘S’ because one note code record can’t be both V and S. 
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Click [Ok] when done 

Example: To build a filter to show only full-time employees in engineering, click edit, set filter, 
select field ‘Employees.EmployeeStatus’, click [Add ->], select ‘is’, ‘equal to’, type 
‘FULLTIME’, then select field ‘Employees.Department’, click [Add ->], select ‘is’, ‘equal to’, 
type ‘Engineering’, then click [Ok]. 

Click the [Ok] button to close this dialog window.  The criteria is used only when the Use 

Criteria option is selected in the Print dialog box. 

Note: the location fields, Branch, Department, Area, and Team, may not be editable. This will 
happen if you are restricted to a specific location defined in Setup, Security, Users.  If, for 
example, your user code has a location set to: Branch: Seattle, Department: Sales, you can only 
view employees in Seattle, Sales.  The Branch and Department fields will already appear in the 
fields list but cannot be changed.  The resulting report will only print employees in Seattle, Sales. 

Graphs Menu: Custom Graphs 

EmployeeFileBuilder uses report files compatible with Crystal Report Generator, and additional 
graphs can be added by users with the full version of Crystal Reports or from add-on packages of 
graphs (contact your local reseller or Paradigm Software for more information). 

Add the new graph to the list of graphs in the system.  Click the [Add] button and the Add Graph 
dialog will be displayed.  To edit a graph already in the system to change the path, tables, and 
customize options for a graph click the [Edit] button and the Edit Graph dialog will be displayed.  
Click [Delete] to remove a graph from the system. 

If you have a purchased set of graphs and wish to add them to your system, click the [Retrieve...] 
button to Retrieve Graphs from diskette. 

Retrieve Graphs 

To retrieve reports from diskette, insert the disk into A: or B:.  Select the drive from the drives 
prompt.  The list of reports will be retrieved from the diskette and displayed as a list.  Click each 
report that you wish to retrieve or click [Select All] to select all the reports.  Click [Ok] to start 
the retrieval process.  All the reports will be copied onto your hard disk and added to your menu 
automatically.  Note: after reports have been retrieved, you may need to set Security Codes and 
Levels for each security code (except SUPER) to allow access of these reports to other users. 

Edit Graph 

This option enables you to add graphs that can be pre-defined or designed by yourself with the 
Crystal Reports package.  Use the Crystal Reports option from the File Menu and you can create 
your own graphs or modify existing ones.  Once the graph has been saved, it can be added to the 
graphs currently installed in EmployeeFileBuilder. 

Enter the group name to add this graph to.  You can enter a new group name and the new group 
will be displayed as an item in the graph menu.  Enter the name for the graph.  This name will be 
displayed in the list of graphs selected.  Give it a descriptive name such as 'Status Comparison 
Graph'.  Enter the filename of the graph as saved in Crystal Reports.  Include the pathname of the 
graph only if the graph is not in the directory specified for Report/Graph Directory in the 
Configure option of the setup menu.  Select the tables used in the graph.  At least one table is 
required for the user to be able to select criteria for the graph.  The Use Criteria option in the Print 
Dialog box uses field names from the tables that are defined for the graph.  For example: If the 
graph created analyses Employees and the Notes for each employee, then the tables will be 
Employees and Employee Notes.  This makes it so the critiria can be selected from any field in 
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the Employees table and the Employee Notes table.  Click on the Allow Criteria option if you 
want users to be able to enter criteria for the graph. 

If you have the Crystal Reports package and wish to edit the actual graph definition, click [Edit 

Graph...] and the Crystal Reports package will be loaded with the graph displayed on screen.  
Modify the graph, then save it, and then exit Crystal Reports.  Run the graph from within 
EmployeeFileBuilder to test the results. 
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Setup Menu 
 

The Setup menu can be reached from any screen by pressing ALT-S. 

� EEO Codes 
� Status Codes 
� User Defined Fields 
� Security 
�  Employee Passwords 
�  User Names 
�  Security Codes and Levels 
� Configure 

Job Categories 

Job Categories are used to classify jobs into categories.  The system comes with pre-defined Job 
Categories according to existing EEO standards.  If EEO reports are not required for your 
organization, you can use the Job Category to organize jobs into groups and report by job 
categories.  To add a new Job Category, click [Add].  To edit an existing Job Category, click on 
the Job Category to edit, then click [Edit].  Enter the Job Category and a description then click 
[Save].  Define the Job Categories before editing Corporate Jobs to better organize your 
company setup. 

EEO Codes 

Equal Employment Opportunity codes used in EmployeeFileBuilder records may be modified to 
reflect the codes applicable to the organization.  The system comes with pre-defined EEO Codes 
according to existing EEO standards.  To add a new EEO Code, click [Add].  To edit an existing 
EEO Code, click on the EEO Code to edit, then click [Edit].  Enter the EEO Code, description, 
and check if Minority, then click [Save].  Consultation with an employment law expert is 
recommended to up-to-date EEO compliance. 

Status Codes 

Status codes reflect the standing of an employee in the organization.  For example, common 
status codes would include FULLTIME, PARTTIME, CONTRACT, NEWHIRE, and so on.  To 
add a new Status Code, click [Add].  To edit an existing Status Code, click on the Status Code to 
edit, then click [Edit].  Enter the Code, description, then click [Save]. 

User Defined Fields 

Each Employee record contains 36 User Defined Fields.  To change description of the contents of 
each field, select User Defined Fields from the Setup menu.  Click on and change any fields 
necessary, and press [Save].  Until these are changed, all fields will display a default heading of 
User Field #X.  Each user defined field also has an option of type.  This allows the restriction of 
the data to valid information of Text, Number, Date, Currency, and Yes/No.  The Number option 
allows only for whole numbers (no decimals).  The currency option allows only numbers and 
periods, normally used to store dollar amounts.  The date type restricts to date only input.  Note: 
these definitions do not change the actual type of the field in the database, it is still a text field.  
The type option just keeps your data consistent.  If a user field, for instance, is defined as type 
‘Date’, someone cannot enter a bunch of characters causing problems when sorting or generating 
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reports. 

NOTE: It is a good idea to lay out what will be stored in each User Defined field before data is 
entered into the system.  This will help avoid confusion if data is entered and then the description 
of a User Defined Field is changed. 

Security 

The Security option (under the Setup menu) provides simple but effective limitations on who has 
rights to access what information.  This security consists of three parts:  

� Employee Passwords that are assigned to each employee 
� Users that are assigned a username, password, security code, and location 
� Security Codes that designate what fields, areas of the program, and reports users 

are allowed to access. 

You can easily enter usernames and passwords under the 'Setup' pull-down menu.  

 

Employee Passwords are used to secure the system by requiring a password when logging in as 
the employee code.  This is to prevent other employees from logging in as another employee and 
tampering with their information. 

Users are recorded with a user name, password, and a user code for the appropriate level of 
access to the EmployeeFileBuilder system.  The user's full name is also recorded in the user 
definition. 

Security Codes define a certain level of access for a class of user.  For example, The ADMIN 
level might have all rights to all employee data screens, but not rights to change other users' 
levels and passwords.  That right is usually reserved for the Supervisor.  On the other hand, a 
DATAENTRY level might have extremely limited rights to view or edit (such that sensitive job, 
payroll, and personal information is not compromised).  On average, no more than five codes are 
necessary for all levels of access. 

 Employee Passwords 

 User Names 

 Security Codes and Levels 

Consult the User's Guide or your System Administrator for details on changing security settings. 

Employee Passwords 

Each employee can be assigned their own unique password.  To do this, select an employee from 
the list and click [Edit].  Type in the current employee’s password (if there is one), then type in 
the new password.  Type in the new password again in the Verify new password box to verify the 
new password.  Click [Save] to make the new password permanent.  For each employee in the list 
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that has a password assigned, a Yes will appear next to their name. 

Consult the System Administrator for details on changing security settings. 

Users 

Users are defined in the Security option from the Setup menu.  A complete user definition 
includes the user code, user name, password, security code for the appropriate security level, and 
the location the user is allowed to view. 

Consult the User's Guide or your System Administrator for details on changing security settings. 

Security Codes and Levels 

Security Codes, set in the Setup menu, define a set of access levels of a certain class of user such 
as SUPER, ADMIN, MANAGER, DATAENTRY, or other type of user.  A few codes are 
defined (with specific access levels), and all users are assigned a code for the appropriate security 
level.  Click [Program Restrictions] to assign which parts of the program are active (can be 
modified). Click [Field Restrictions] to assign which fields in the program are either visible (can 
be seen) or active (can be modified).Click [Reports] to assign which Reports are available. Click 
[Graphs] to assign which graphs are available. 

A special code of ‘DEFAULT’ is used when an employee logs in with their employee code.  This 
code should only allow an employee read-only access and no access to corporate views or 
corporate policy information.  Reports and graphs should be restricted as well. 

Consult the User's Guide or your System Administrator for details on changing security settings. 

Security Code: Reports 

The Reports and graphs options select which reports and graphs the user is allowed to view.  
Place a check mark next to each report that the user is allowed to run. And click [Save] when 
finished.  Click [Set All] to check all reports, click [Clear All] to clear all checkmarks. 

Program/Field Restrictions 

Program restrictions allow for the restriction of individual elements in the program to be turned 
off.  This allows for the program to ‘appear’ as if all features are available to one user while 
another user may have more or less options available.  A user could have access to only the 
Employee Folder, Main Form for instance. 

Field restrictions allow for both showing a field and allowing edits of a field.  Some information 
may be too sensitive for some users to display such as salary information, job history, etc. so 
these fields will not be visible to the user.  Other information such as addresses, phone numbers, 
etc. may be visible for reference but only authorized users are allowed to change the information. 

NOTE: The field restrictions do not effect reports.  The employee information report, for 
instance, cannot be limited by field restrictions so this report must be disabled if restricting 
visibility of some fields. 

Setup Menu: Configure 

General 

If the Employee Database (EMPLOYEE.MDB) file is stored on a different drive and/or directory 



EmployeeFileBuilder  User Manual 

28 

enter the filename with the full path in the Employee Database: option.  This option is used if in a 
multi-user environment where the program may be installed on a local workstation but the 
database is stored on a network file server.  The database specified will be automatically opened 
when the program is run or when the ‘open existing database’ button on the Welcome window is 
pressed. 

To specify a different path for the reports, specify the pathname of where the reports are stored in 
the Report Directory: option.  Note: Reports that are defined in the Customize Reports without 
pathnames will use the path entered here, otherwise the path explicitly entered for the report will 
be used. 

If Show Current User Name option is checked, the current user’s login name is displayed in the 
lower right corner of the window. 

System Colors 

The system colors tab allows for customization of the selected folder color, the deselected folder 
color (background folders), the folder background color (behind the tabs), and the field highlight 
color (when the cursor is placed on a field). 

Click the [Colors...] option to the right of each item to change.  Click the color you wish to 
change to, or click [Define Custom Colors...] to define colors not shown.  Refer to Microsoft 

Windows manual for more information on Control Panel - Setting Colors. 

Utility Programs 

If you use Microsoft Access or Crystal Reports, you need to define where the programs are stored 
in order for the appropriate File Menu options to work.  Click the [Browse...] button to search 
through the directories and click [Ok] to select the correct directory. 

Spelling 

This dialog lets you configure the spelling checker within JIAN EmployeeFileBuilder.  The 
spelling checker installs with two dictionaries: a standard 100,000 word dictionary as well as a 
custom dictionary for your use to add your own words that are not included in the standard 
dictionary.  You can also set spelling options: 

Automatic Suggestions 

This option selects whether the spelling checker automatically suggests correct spellings for the 
word highlighted. 

Ignore Full Caps 

If this option is checked, words in all caps will not be checked 

Ignore Partial Numbers 

If this option is checked, words with numbers included in them will be ignored. 

Allow Joined Words 

If this option is checked, words with hyphens in them will be checked as two separate words.  If 
they are correct, the full word is correct.  Otherwise the whole word with hyphen will be checked. 
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Recheck Typed Replaces 

Determines whether words typed in to replace the checked word get rechecked by the spell 
checker. 

Suggestion Search Limit: 

Sets the overall number of suggestions that are investigated for each misspelled word. 

Click [Ok] to save the information.  Note: This information is saved into the file WWEF.INI.  If 
problems occur trying to load the EmployeeFileBuilder program, check that all pathnames 
specified in WWEF.INI are correct. 

Retrieve 

The retrieve dialog allows for the easy retrieval of custom utilities, reports, etc. by third party 
vendors.  If the file is provided by diskette, insert the diskette and select the drive (a:).  The list 
will automatically show what is available on the diskette.  Select one or multiple entries or click 
[Select All] to select all items.  Click [Ok] and the items will be retrieved from the diskette into 
the system. 
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Employee Folder 
 

This folder contains the primary records in EmployeeFileBuilder; personal information, picture, 
benefits, history, job, and associated information. The following options and tools appear in the 
Employee folder: 

� Edit Employee 
� Employee Location 
� Employee Picture 
� Employee User Fields 
� Employee Comments 
� Employee Relatives 
� Employee Benefits 
� Employee Time-off Benefits 
� Employee Time Sheets 
� Employee Notes 
� Employee Performance 
� Employee Job History 
� Employee Certifications 
� Employee Education 
� Employee Statistics 
� Employee Attachments 

This is the default folder when EmployeeFileBuilder starts.  To return to this folder, click on the 
/Employees\ folder tab. 

Edit Employee 

Editing and addition of employees is done in a concise data entry screen that is displayed when 
you select an add or edit function. 

To edit an employee, click on the [Edit] button or select Edit Employee from the Edit menu.  If 
a new employee is to be added, select [Add] from the Main Form.  Add the employee's personal 
information and press [Save]. 

The edit form is divided into 6 tabbed pages: General, Personal, Current Job, Location, User 
Fields, and Comments. 

General 

The General page contains basic information on an employee like name, address, phone numbers, 
E-mail addresses, etc.  The Employee Code is used to identify the employee.  This must be a 
unique code.  The Employee Status field is used to identify the status of the employee, 
FULLTIME, PARTTIME, TEMP, TERMINATED, etc.  Click [Select] to select a status. 

Personal 

The personal page displays personal information about the employee such as Social Security 
Number, Birthdate, Marital Status, Driver’s License Number, etc.  Select the EEO Code for the 
employee by clicking the down arrow button.  Double-click the EEO Code field to bring up the 
EEO setup window for adding custom EEO Codes. 
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Current Job 

This page displays current job information for the employee such as Job title, salary, category, 
dates, and descriptions.  To assign a job to an employee, click the [Select] button to the right of 
Job Code.  Select a job and all information will be updated from the corporate policy.  This 
function is best used when first assigning a job to an employee.  If an employee changes jobs, use 
the change job option in the employee job history page.  This will help maintain a history of each 
job change, dates, and reasons. 

Location 

This page contains the Branch, Department, Area, Team, and Supervisor for the current location 
of this employee.  To change an employee’s location click [Location] and select a location from 
the organization chart.  If you type in a location that does not exist in the organization chart, the 
location will be added automatically.  This is to assure that the organization chart is always up to 
date.  User the [Select Supervisor] button to help select a supervisor from a list of current 
employees in the system. 

User Fields 

The user fields page contains 36 user defined fields.  This page is broken down into 3 separate 
pages of 12 user fields each.  The data allowed in the user field depends on the setting in the user 
fields option in the setup menu.  Some may allow any text and others are restricted to only accept 
numbers, dates, or yes/no entry.  When a user field which allows for text entry is selected, a down 
arrow appears to the right of the field.  Select a value for this field by clicking the down arrow.  
Double-click the user field to add your own user defined lists.  You could set up a user field to 
track hobbies and add items to the list of different types of hobbies. 

Comments 

The Comments page contains any additional comments about the employee.  This is a free-form 
area for general information.  Use the spell check button to check spelling of the text entered 
here. 

When the desired information is complete, press [Save] and the information will be updated for 
the employee.  Click [New] to add a new employee, click the left and right arrow buttons to move 
between employees.  Click [Close] to return to the Employee Folder. 

Edit Employee Location 

Each employee has a location specified by Branch, Department, Area, and Team.  The location 
can be set from the Employee Folder Main Form or in the Employee Edit screen.  Click 
[Location] and the location dialog box will appear.  Type in the desired location or click [Select 

Location] to select a location as defined in the Organization Chart. 

Use this form to enter the employee’s supervisor as well. 

Edit Employee Picture 

EmployeeFileBuilder comes complete with a picture editor.  To edit an employee's picture, go to 
the Employees Folder, click [Main Form] then click [Picture].  You can also edit the picture by 
double-clicking on the picture itself. 

To import a picture from a saved file, select File then Open.  From here, you can import many 
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different picture formats such as Windows/OS2 bitmap (BMP), Windows device-independent 
bitmap (DIB),  Compuserve graphics interchange (GIF), Joint Photographics Experts Group 
(JPG),  ZSOFT bitmap/Paintbrush (PCX), TrueVision Targa (TGA),  and tagged image file (TIF).    
Enter the name of the file and click [Ok].  The image is loaded and displayed in the window. 

If you have a TWAIN compliant scanner attached to your computer, you can directly capture 
images and save them in EmployeeFileBuilder. Select File then Acquire and the scanners 
software will load and let you scan the image.  When you are done, the image will be imported 
directly into the Edit Employee Picture window.  Use Select Source to select from more than one 
scanner attached to your system. 

Often, the image that is scanned or photographed does not look right.  Either it may be too blurry 
or too dark.  The image can be enhanced by clicking the Image menu and selecting from one of 
the items: Lighen, Darken, Smooth, Sharpen, Negative, Gamma Correction, Extract Edges, 

Convert to grayscale, or Reduce Colors.  By experimenting with these options you can improve 
the quality of the image. 

If the image that was scanned, for instance, was upside-down, you can flip the image by clicking 
Transform and use either Flip Horizontal or Flip Vertical.   

If you only want to save part of an image, like the employee's head, and not all the surrounding 
scenery, click and drag a rectangle around the area you wish to save, then select Edit and then 
Crop.  Everything outside of the rectangle is deleted from the image.   

Use Undo to change the image back to its previous state before any operation. 

Use the Save As... option to save the employee's picture in one of the formats as specified above.  
Enter a new filename for the picture to be saved.  This option is useful if you need to save the 
image in a different format for editing by your favorite paint program. 

Print badges by selecting the [Print Badge] option from the File menu.  This will print a standard 
2" x 3.25" wallet-sized photo-identification badge to the default printer. 

To return to the Employee Folder with the new picture, select File and Exit and a message will be 
displayed asking you if you want to update the employee picture.  Click [Yes] to save the picture. 

Employee User Fields 

The User Fields page in the Employee folder displays all the user defined fields with the 
description in the first column and the value in the second column.  To edit the user defined fields 
for an employee click [Edit] on the Main Form and click the User Fields tab. 

Employee Comments 

The Comments page in the Employees folder displays the comments entered for the current 
employee. To edit the comments for an employee click [Edit] on the Main Form and click  the 
Comments tab. 

Employee Relatives 

The Employee Relatives page displays the name, relation, phone, and emergency contact status of 
all the relatives for the current employee.  Click [Add] to add a relative to the current employee.  
To edit employee relative, select the relative from the list and click [Edit], or double-click on the 
relative to edit.  To delete a relative, select the relative from the list and click [Delete]. 
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Edit Employee Relative 

Editing and addition of employee relatives is done in a concise data entry screen that is displayed 
when you select an add or edit function. 

The edit form is divided into 4 tabbed pages: General, Phone Numbers, Personal, and Notes 

General 

The General page contains basic information on an employee relative like name, address, relation, 
emergency contact, and dependent. 

The Relation field is used to identify the relation of the relative, FATHER, MOTHER, SON, 
DAUGHTER, etc.  Click [Select] to select a relation.  Relations can be added by clicking 
[Modify >>]. 

Phone Numbers 

The Phone Numbers page contains many contact phone numbers and other types of phone 
numbers to contact the relative.  These numbers can be important if the relative is an emergency 
contact. 

Personal 

The personal page displays personal information about the employee relative such as Social 
Security Number, Birthdate, and Gender. 

Notes 

Use notes to add any additional information about the relative.  Click the spell check button to 
check your spelling. 

Employee Benefits 

The Employee Benefits page displays the name, date eligible, date enrolled, and date withdrawn 
of all the benefits for the current employee.  Click [Add] to add employee benefi  to the current 
employee.  To edit employee benefit, select the benefit from the list and click [Edit], or double-
click on the benefit to edit.  To delete a benefit, select the benefit from the list and click [Delete]. 

Add Employee Benefit 

To add a benefit to an employee, click [Add].  The Add Employee Benefit window will be 
displayed.  Select the benefit to add from the list displayed of corporate benefitsand click [Next 

>].  Enter the date the employee enrolled, eligible, and when the benefit is to start.  Enter any 
additional comments about this benefit and click [Finish] to add the benefit to the employee. 

Edit Employee Benefit 

To edit a benefit for an employee, select the benefit and click [Edit].  If the benefit is no longer 
valid for the employee, enter a date in the Date Withdrawn field. 

Employee Time-off Benefits 
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The Employee Time-off Benefits page displays the description, start date, available, and as of 
date of all the time-off benefits for the current employee.  Click [Add] to add employee time-
off benefit to the current employee.  To edit employee time-off benefit, select the benefit from 
the list and click [Edit], or double-click on the benefit to edit.  To delete a benefit, select the 
benefit from the list and click [Delete].  To recalculate a benefit, select a benefit in the list and 
click [Recalculate]. 

Add Employee Time-off Benefit 

To add a time-off benefit to an employee, click [Add].  The Add Employee Time-off Benefit 
window will be displayed.  Select the benefit to add from the list displayed of corporate time-off 
benefits and click [Next >]. 

There are two methods in which you can set up an employee’s calculations for their time-off 
benefits.  Read both of the following procedures and decide which one you want to use. 

1.  Method #1 will allow you to set up a complete history of the employee’s time-off activities 
since they have been employed with the company.  This procedure will be effective if you want to 
transfer all of the employee’s time-off history into EmployeeFileBuilder.  When you set up an 
employee with this kind of time-off benefit, EmployeeFileBuilder will bring forward past 
accumulated time since the employee’s first benefit period (when they started their employment).  
This procedure requires that you manually input (by use of Notes) all of their time-off activities 
from the very beginning of their employment prior to assigning this time-off benefit.    

The next screen already provides you with the appropriate information needed to bring forward 
an employee’s complete time-off accumulation history.   

The Enter the date the employee enrolled in the time-off benefit: field will show today’s date.  
This date does not affect any calculations, but serves as a record of when the benefit was assigned 
to the employee— this will prove helpful in the future if you need to change policy accrual rates.  
Typically, an employee would enroll on or around their hire date or after a probationary period.   

The Enter the date when the benefit starts: field will show the date that the benefit started 
(derived from when the employee was hired and the time-off benefit you have created in your 
Corp. Policy folder). 

The Calculation start date: field will show the same date as the Enter the date when the benefit 

starts: field.  This will enable EmployeeFileBuilder to compile the accumulated time-off from the 
very beginning of the employee’s eligibility.   

The Balance as of the calculation start date: should read 0.   

Now ‘click’ on the [Finish] button to add this time-off benefit to the employee.  
EmployeeFileBuilder will make the calculations and show you the new benefit with it’s 
information in the Employee Time-off Benefits page. 

2.  Method #2 will allow you to set up an employee’s time-off benefit that starts with a known 
time-off balance from a specific date.  You would want to use this procedure if you don’t want to 
manually build or track an entire history of an employee’s time-off, or if you want 
EmployeeFileBuilder to start tracking the time-off history from this date forward. 

The Enter the date the employee enrolled in the time-off benefit: field will show today’s date.   

The Enter the date when the benefit starts: field will show the date that the benefit started 
(derived from when the employee was hired and the time-off benefit you have created in your 
Corp. Policy folder). 
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In the Calculation start date: field, enter the date that the last known amount of time-off was 
available to the employee.  EmployeeFileBuilder will compile the accumulated time-off from this 
point forward, in addition to the balance that you enter. 

The Balance as of the calculation start date: should read the amount of time that was available at 
the Calculation start date:.  If the employee’s time-off benefit should start with an opening 
balance, enter it here.  

Click [Finish] to add the time-off benefit to the employee. 

Edit Employee Time-off Benefit 

From within the Time-off Benefits page, select the benefit you wish to edit, then ‘click’ the 
[Edit] button located at the bottom of the screen.  The Edit Employee Time-off Benefit screen 
will appear. 

From within the General tab, make changes in the available fields.  Notice the Code, and Benefits 

are calculated in units of fields cannot be edited because they have been defined in your Corp. 

Policy folder.   

Enter the Date Enrolled and Benefit Starting Date of the benefit as needed.   

Use the Benefit Ending Date: field if you want to stop this time-off benefit from accruing hours.  
This will prove useful when you want to replace an existing time-off benefit with a different one, 
but want to keep a record of the past benefit’s accrual history.  You may also use this field when 
suspending a time-off benefit during a personal or medical leave.  To restart the time-off benefit 
accrual, delete the date in the Benefit Ending Date: field and set the Recalculation Date: to equal 
the date of reactivation.  Then ‘click’ the [Recalculate] button to update the time-off account.   

If, for any reason, you want to change the Current Available: field, do so and enter the date this 
change is to take effect. 

The Recalculation date: field will automatically default to tomorrow’s date to ensure your 
recalculations will be run through today. 

After your changes have been made, ‘click’ the [Recalculate] button at the bottom of the screen 
to activate the changes you have made.  Then ‘click’ [Save] to complete the task. 

Select the History tab located at the top of the Edit Employee Time-off Benefit screen to view 
the history and running balance of a particular time-off benefit.  To see the latest balance figures 
of a benefit, ‘click’ the [Recalculate] button. 

Note:  If you wish to change the content of a particular Time-off benefit, or add a different one, 
do so in the Corp. Policy folder. 

Employee Time Sheets 

An employee’s time sheets provide information on hourly work history, what jobs an employee 
worked on, and how long it took to complete them. 

The Employee Time Sheets page displays the date, project code, activity code, schedule, and 
actual of all the time sheets for the current employee.  Click [Add] to add employee time 
sheets to the current employee. To edit employee time sheets, select the time sheet from the list 
and click [Edit], or double-click on the time sheet to edit.  To delete a time sheet, select the time 
sheet from the list and click [Delete].  Click the [Views] button to show the Employee Time 
Sheet View.  
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Edit Employee Time Sheet 

Insert the date of entry from the Date field’s calendar icon.  The Project Code and Activity Code 
fields allow you to select items from the [Select...] buttons to ensure consistent data entry.  

The Project Code typically refers to the project on which the employee is working.  The Activity 

Code typically refers to the type of work being done.  For example, building a new retail store is a 
project, laying the foundation is an activity.  

 After ‘clicking’ the [Select...] button for the Project Code or Activity Code fields, a screen 
appears enabling you to view and select the desired Code with its Description.  You may also 
select the [Modify>>] button located at the bottom of the screen to Add, Edit, or Delete a 
particular code. 

Once you have selected the proper Project Code, Activity Code, and Description for the employee 
time sheet, enter the Scheduled Starting and Ending times of the particular task by selecting the 
clock icons located to the right of their respective fields.  Then input the estimated Days and/or 
Hours it will take to complete the task.  Do the same with the Actual Starting and Ending times 
when the task is completed, and input any Overtime Hours the employee has logged if necessary.  
‘Click’ [Save] when you have finished. 

Employee Time Sheet View 

The Employee Time Sheet View screen provides a calendar-based view of the time sheets 
recorded for an individual employee.  You may view this calendar by year, month, or day by 
selecting the Year, Month, or Day folders located on the upper left-hand side of the screen.  To 
move year-to-year or month-to-month, use the arrow buttons on the bottom left-hand side of the 
screen.  If you need to view a particular day, ‘click’ on the actual day on your calendar, and select 
the Day folder.  This will provide a more detailed view of the time sheets for that employee. 

Employee Notes 

To view or edit an employee's notes, click [Notes] in the Employee Folder.  Employee Notes are 
different from Comments in that they are classifiable, and date-specific.  For example, notes 
about a new hire's resume would be placed in Comments, while a vacation, string of absences, or 
doctor's appointment would be recorded as a Note.  Notes are predefined in the Corporate Policy 
folder by Note Code. 

 Edit Employee Note 

 Employee Notes View 

Edit Employee Note 

To edit the list of an employee's notes, press [Add] or [Edit].  Select a note code from the list box 
at the upper-left.  Specify a starting and ending date/time (if the ending date & time do not apply, 
they will not appear on the screen), and select between the Excused and Unexcused check-boxes. 

Add additional information in the field provided as necessary to provide further documentation of 
the event.  Press [Save] when the note is complete.  If additional information is entered, the check 
box at the right side of the note code list will be marked. 

Employee Notes View 

The Employee Notes View screen provides a calendar-based view of the notes recorded for an 
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individual employee.  You may view this calendar by year, month, or day by selecting the Year, 
Month, or Day folders located on the upper left-hand side of the screen.  To move year-to-year 
or month-to-month, use the arrow buttons on the bottom left-hand side of the screen.  If you need 
to view a particular day, ‘click’ on the actual day on your calendar, and select the Day folder.  
This will provide a more detailed view of the notes for that employee. 

 Note Colors  

Note Colors 

Change the notes you want to view by selecting the [Note Colors] button located at the bottom of 
the screen.  Next, assign the notes to the colors you want to view by ‘clicking’ on the “down” 
arrow next to the Note Code field.  Select [OK] when you have finished assigning the colors. 

Employee Performance 

EmployeeFileBuilder lets you keep detailed records on the unusual or dramatic date-specific 
events that arise during an employee’s time with your company.  These events may include 
positive notations, such as completion of a project or attainment of a professional goal.  They may 
also note negative developments, such as a project that lags far behind schedule, or an altercation 
with another person on the job.  Make use of entries on Employee Performance when evaluating 
an individual for advancement or dismissal. 

Edit Employee Performance 

Employee Performance View 

Edit Employee Performance 

To edit the list of an employee's performance, press [Add] or [Edit].  Specify a date of the 
performance.  Select whether the performance entry is positive or negative.  Enter a short 
comment and any additional notes.  Click [Save] to save the entry. 

Employee Performance View 

The Employee Performance View screen provides a calendar-based view of the performance 
recorded for an individual employee.  You may view this calendar by year, month, or day by 
selecting the Year, Month, or Day folders located on the upper left-hand side of the screen.  To 
move year-to-year or month-to-month, use the arrow buttons on the bottom left-hand side of the 
screen.  If you need to view a particular day, ‘click’ on the actual day on your calendar, and select 
the Day folder.  This will provide a more detailed view of the performance for that employee. 

Employee Job History 

EmployeeFileBuilder keeps a record of all past and present jobs recorded in the Job History form.  
If a new job is entered, the current job is added to the historical list of positions.  If an employee 
terminates, there is an option for the current job to be set to “Terminated.” 

To add a new job (hire, promotion, or transfer), click [Change Job].  If there is a current job, a 
form will appear for entry of reasons for ending that current job.  Press [Save] to close this form.  
EmployeeFileBuilder will then automatically proceed to a new job entry form.  Fill this out and 
press [Save].  The old job will be transferred to the Work and Salary History chart, and the new 
one will be saved as Current. 

� Edit Current Job 
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� Change Job 
� Terminate 
� Edit History 

Change Employee Job 

To record a job change or increase in salary, ‘click’ the [Change Job] button located on the 
bottom of the Job History page.  You will next see a prompt with the date of change, and an 
opportunity to make a note about factors contributing to the change.  ‘Click’ the [Save] button 
and you will see the job information window.  Here you may make the adjustments in salary, or 
change the job code.  Since EmployeeFileBuilder is assuming a change job is taking place, the 
Date Started: field is changed.  If the employee is only getting a pay raise, change the Date 

Started: field back to the original date the employee started this position.  When you select the 
[Save] button again, these changes will display as Current Job Information, and the past salary 
and job information will display on the lower portion of the screen under the title Confidential 
Work and Salary History.   

Edit Current Job 

To edit an employee’s current job, press [Edit Current].  Enter the Job Code as defined in Jobs 
in the Corporate Policy folder.  After the Job Code is entered and you press ENTER, the default 
information about that job, such as Title and Pay, will be automatically entered into the 
appropriate fields from the Corporate Job.  Enter the information as it pertains to this employee 
and click [Save] to save the current job.  The changes will be saved without alteration of the job 
history.  If the changes are significant enough to warrant an entry in the job history as a new 
position, press [Change Job].  This enables you to track history of when and what changed 
during the person’s employment. 

Edit Employee Job History 

To make changes in, or view a full entry in the Work and Salary History chart, select a job and 
press [Edit History] (this button will be inactive if no Job History exists).  The Edit Employee 
Job History box will be displayed.  This box shows all information BEFORE the job was 
changed.  This shows the location the employee was at, as well as past salary information.  Click 
[Job End Reason], to display the text of why the job was changed. 

Terminate Employee 

To mark and employee as terminated, press the [Terminate] button.  Enter a date and the 
nature/reasons for the termination in the Termination form.  Press [Save].  The current job will be 
added to the Job History, the current job will be erased, and the Employee Status will be changed 
to ‘TERMINATED’. 

Note: If the employee is re-hired, just click [Edit Current] and enter the new job information, 
then change the employee status from ‘TERMINATED’ to their new status. 

Employee Certifications 

EmployeeFileBuilder lets you keep detailed records on the certifications maintained by each 
employee.  Track the certification type, date, and additional notes. 

The Employee Certifications page displays the type, expiration date, and notes of all the 
certifications for the current employee.  Click [Add] to add employee certifications to the 
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current employee.  To edit employee certifications, select the certification from the list and click 
[Edit], or double-click on the certification to edit.  To delete a certification, select the item from 
the list and click [Delete]. 

Edit Employee Certification 

To edit a certification click [Edit].  Enter the type of certification, the expiration date, and any 
additional notes about the certification.  Click [Save] to save the entry. 

Employee Education 

EmployeeFileBuilder provides you with the ability to track information on the education levels of 
all your employees.  To view or enter information on an employee’s education, ‘click’ on the 
[Education] button located on the right side of the Employees folder.  This will activate the 
Employee Education page. 

To edit employee education information, select the [Edit] button located on the bottom of the 
employee’s Education page.  Make the necessary changes and select [Save] when you have 
finished. 

To delete an education entry, “highlight” the actual entry you wish to delete and select the 
[Delete] button located on the bottom of the employee’s Education page.  Then select [OK] to 
delete the entry. 

Edit Employee Education 

In the Edit Employee Education screen, three folders are available:  Address, Phone Numbers, 
and Notes.  In the Address folder, input basic information on the institution in which the 
employee was enrolled.  Input if and when the employee graduated and utilize the [Select...] 
button for the Degree field to create and maintain a consistent list of academic degrees.  The 
Phone Numbers folder allows you to input contact names and relevant telephone numbers.  And 
finally, the Notes folder lets you enter any additional information concerning an employee’s 
education. 

Employee Attachments 

To attach files to an employee record, the Employee Attachments option provides a way of 
documenting information on an employee using standard files created by other software.  Files 
can be attached by a filename or embedded in the database. 

To view an employee’s attachments, select the [Employee Attachments] button located on the 
right side of the Employees folder.  The Employee Attachments screen will come into view. 

To add an employee attachment, select the [Add] button located on the bottom of the page. 

To edit employee attachments, select the [Edit] button located on the bottom of the page.  
Make the necessary changes and select [Save] when you have finished. 

To delete an attachment, “highlight” the actual entry you wish to delete and select the [Delete] 
button located on the bottom of the page.  Then select [OK] to delete the entry. 

To open an employee attachment for viewing or editing, select the [Open] button located on 
the bottom of the page. 

If a Paperport scanner is attached to the system, click the [ImageLink] button to view and attach 
scanned documents.  To scan a document into an employee's record, click [ImageLink] and 
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insert the document into the scanner, then close the PaperPort software.   

Add Employee Attachment 

To add a file to the employee's record click [Add].  Type in the path and filename of the file you 
want to attach to the employee or click [Browse…] to select browse for the file. 

Link Options 

There are two options available for the attachment.   

The Embed option reads the contents of the file and inserts it into the database.  Some advantages 
to embedding are: 1) The file resides in the same location as the other employee data. 2) Since the 
file is embedded in the database, it is also secure.  It can only be accessed by authorized users.  
The database can be backed up or moved and the attachments move with it.  The disadvantage of 
embedding a file is that the database can grow larger than expected. 

The Link option will only reference the file by the path and the filename.  Some advantages to 
linking are: 1) the file can be edited by other users outside of the program, and 2) the database 
does not grow larger with each attached file.  Disadvantages are 1) Other stations on the network 
may not have access to the physical path and file, 2) the linked file may be deleted, edited, or 
moved outside of the program by unauthorized users.  Note: If this document is to be accessed by 
other users on the network, the path and file must be the same for all users.  To make this 
possible, all stations that are to access the attachment should have the same attached drive (such 
as N:\) pointing to the same directory. 

Click [Next>] to continue adding the attachment: 

Enter the name of the attachment.  This defaults to the filename (without the path and extension).  
Enter a category the attachment is to be stored under.  Click [Select…] to select or add new 
categories to the system.  Enter the type of the document.  This defaults to the extension of the 
file but can be changed to a more descriptive type. Click [Select…] to select or add new 
document types to the system.  Enter any additional comments about the attachment in the 
comments field. 

Click [Finish] to add the attachment to the employee, or [Cancel] to abort. 

Edit Employee Attachment 

To edit the information on an attached file click [Edit]. 

Enter the name of the attachment.  This defaults to the filename (without the path and extension).  
Enter a category the attachment is to be stored under.  Click [Select…] to select or add new 
categories to the system.  Enter the type of the document.  This defaults to the extension of the 
file but can be changed to a more descriptive type. Click [Select…] to select or add new 
document types to the system.  Enter any additional comments about the attachment in the 
comments field. 

Note: To change the filename of the attached file or change how it is linked, delete the attachment 
and click [Add]. 

Open Employee Attachment 

To open an employee attachment for viewing or editing, highlight the attachment and click 

[Open]. 
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If the attached file is linked, the file will be opened by the appropriate program for viewing or 
editing. 

If the attached file is embedded, the system will export the file to the windows temporary 
directory, then opened by the appropriate program for viewing or editing.  If any changes are 
made to the file, save the changes then click the [Update Database…] button to import the file 
into the database.  Click [Close] when all changes have been made and saved and the document is 
closed.  Warning: If changes were made but not saved, the Close button will not update the 
database with the changes.  Also, if the document is still open and close is clicked, any additional 
changes to the file will not update the database. 

NOTE: On 32 bit systems such as Windows 95 and Windows NT.  The associated program may 
not open properly.  This is due to incompatibilities with long filenames and this 16bit product.  
To open the document, first open the associated program, then click Open.  For example: If the 
attached document is a Word document, open Word FIRST, then click Open. 

Employee Statistics 

The Employee Statistics form shows up-to-the-minute information about an individual employee.  
When this screen is displayed, information is calculated such as: 

• Length of employment 

• Expiration of Work Permit, I9 Form 

• Number of Performance Entries along with percentages positive or negative 
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Corporate Views Folder 
 

Corporate Views provides several on-screen perspectives on the company, from organizational 
layout and hierarchy to employee performance.  The following options appear in the Corporate 
Views folder. 

� Custom Views 
� Benefits View 
� Time-off View 
� Note Code Summary 
� Status Code Summary 
� Organization Chart 
� Statistics View 

To open this folder, click on the /Corp Views\ folder tab. 

Custom Views 

EmployeeFileBuilder Custom Views provide limited report-like functions in a graphic on-screen 
format for speed and ease-of-use.  These views can be built and modified to suit the specific 
needs of the company.  The Custom Views page displays the name of the view, comments, and 
the date it was last run.  To run a view click [Run].  The results of the view will be displayed in a 
grid for viewing and/or printing. To add a custom view , click [Add].  The custom view wizard 
will be displayed.  To edit a custom view, click [Edit]. To delete a custom view, “highlight” the 
actual entry you wish to delete and select the [Delete] button.  Then select [OK] to delete the 
entry. 

Add Custom Views 

To create a custom view, select [Add] from the bottom of the Custom Views page to activate the 
Custom View Wizard.   

Give the view a name, select an additional table (if needed) to be included in the custom view, 
and enter any comments or descriptions of the view.  If you want users to be able to do mass 
updating of the data within the view, check the option Allow Editing of data within the custom 

view.  If this option is checked, then the user can edit the employee records in the view, otherwise 
the view is read-only.  When all the information is entered, ‘click’ [Next>]. 

Now you need to setup the fields for your custom view.  With your mouse, “highlight” a desired 
topic from the list of Available Fields.  Then select the [Add ->] button located on the right side 
of the Available Fields box to add it to the list of fields that will be shown in your custom view.  
This can also be accomplished by double-clicking the field in the Available Fields list. 

After you ‘click’ on the [Add->] button, a Criteria for field option will instantly appear enabling 
you to pinpoint exactly how you want the field to work for your custom view.   

To build criteria, do the following steps: 

The first drop-down selects ‘is’ or ‘is not’. 

The next drop-down list selects how the comparison is to be done. ‘any value.’, ‘equal to’, ‘less 
than’, ‘less than or equal to’, ‘greater than’, ‘greater than or equal to’, ‘between’, and ‘one of’. 

A new drop-down will appear to the right allowing you to enter criteria.  Click the drop-down 
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arrow to select from the actual data in the database.  If the ‘between’ option is selected, two drop-
down boxes will appear allowing for a starting and an ending value to be entered.  This option is 
preferable when you need to select a range of values.  Example: all employees hired last year 
would be ‘Employees.HireDate’ is between ‘1/1/95’ and ‘12/31/95’.  The last option ‘one of’ is 
very useful when you need to select multiple values at the same time.  Enter each criteria then 
click [Add] to add it to the list.  To delete an item, select the item in the list and click [Delete].  
Example: all full-time and part-time employees would be ‘Employees.EmployeeStatus’ is one of 
‘FULLTIME’, ‘PARTTIME’.  It would be incorrect to do the following: 
Employees.EmployeeStatus is equal to ‘FULLTIME’ and Employees.EmployeeStatus is equal to 
‘PARTTIME’ because one employee cannot be both FULLTIME and PARTTIME. 

Check the option Field is visible to display the field in the view.  If you want a view to be filtered 
based on a field such as salary but don’t want to actually display salaries, keep this option 
unchecked. 

Repeat the above process for each field you wish to include in the custom view.  If you have 
multiple fields for the view, utilize the Move buttons to arrange the fields to your liking.  Just 
“highlight” the desired field and select [Move Up] or [Move Down] to place it in the order you 
want.  When you have finished, select the [Next >] button to define the sort order of your custom 
view. 

Now that you have defined the information that will be available in the custom view, the final 
step of selecting the sort options is next.  This will allow you to view the listings in alphabetical 
order, whether A to Z (Ascending), or Z to A (Descending).  All you have to do is select the Sort 

by field’s drop-down menu, and select the field you have already defined in the previous screen.  
Then, ‘click’ on the Ascending or Descending options to define the sort order.  If necessary, 
repeat the step for all the fields you are using.  When you have completed defining the sort 
options, select the [Finish] button on the bottom of the screen to save your custom view.  

Edit Custom Views 

To edit an existing custom view, “highlight” the name of the view you want to change and select 
the [Edit] button located on the bottom of the Custom Views page.  This will activate the Edit 

Custom Views screen.  Making the changes is done in the same manner as creating a custom 
view.  Refer to add a custom view  for instructions. 

Run Custom View 

To run a custom view once it has been created, select the view from the list and click [Run 

View].  You will then get a view of the fields and the records defined for the view.  You can 
move to any field and any record in the view.  Note: If editing is allowed for the view, be careful 
not to enter information that is invalid for certain fields such as entering an Employee Status that 
does not exist. 

 

To print the information displayed in the view, select Print from the File menu.  The Print dialog 
box is displayed.  Click [Ok] to print the information. 

The Edit menu provides a way to copy the current record or all records to the clipboard.  To copy 
a single record, move the cursor to any field within the record to be copied and select Edit, Copy.  
To copy all records to the clipboard, select Copy All. Then you can paste the records into a 
program such as Microsoft Excel for further number crunching or graphing. 
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The View menu provides options to hide the tool bar and the status bar to gain more space for 
data. 

The Records menu provides options to move between records, refresh data, and set editing.  The 
Goto menu provides methods for navigating through records.  You can go to the Next, Previous, 
First, and Last records.  The toolbar provides an up-arrow and a down-arrow button to move to 
the next and previous records.  The Refresh option refreshes the data in case updates were made 
on other stations in a multi-user environment. If the custom view allows edits but you do not want 
to accidentally change information, uncheck the Editing Allowed option.  When this option is not 
checked, the view is read-only.  If the view does not allow edits, then this option cannot be 
changed. 

The Layout menu provides the ability to Hide columns, show all columns.  To hide a column, 
place the cursor in the column you wish to hide and select Hide Column.  To show all columns 
again, select Show All Columns.  

Columns can be re-ordered by dragging the column headers left or right. 

To close the view select Close from the File menu or click the [Close] button on the toolbar. 

Corporate Benefits View 

The Benefits View shows the breakdown of how many employees are enrolled, will be eligible in 
1 month, 1 quarter, and 1 year, quantity active, and quantity inactive.  From here you can see how 
many employees are eligible for health insurance next quarter.  If you want to know WHO is 
eligible for health insurance next quarter, click on the box in the row for Health Insurance and the 
column Eligible in 1 Quarter, then click [Employees].  You can also Double-click on any row 
and column to show a list of employees.  Note: when the list of employees is displayed, you can 
double-click on the employee to jump to their record in the employees folder. 

Corporate Time-off View 

The Time-off Benefits View shows the breakdown of how many employees are enrolled, active, 
and inactive.  From here you can see how many employees are enrolled in Vacation Days Sample 
2 benefit.  If you want to know what employees are active in that benefit, click on the box in the 
row for Vacation Days Sample 2 and the column Quantity Active, then click [Employees].  You 
can also Double-click on any row and column to show a list of employees.  Note: when the list of 
employees is displayed, you can double-click on the employee to jump to their record in the 
employees folder. 

Corporate Note Code Summary 

Note Code Summary displays a summary of all the note codes and their usage.  This view shows 
how many employees have used the note Today, This Week, This Month, This Quarter, and This 
Year. If you want a list of the employees who used a particular note, double click on any row and 
column to show a list of employees.  For instance, you by double-clicking on the row ‘Vacation’ 
and the column ‘Scheduled’, you can list all the employees scheduled for a vacation.  Or, by 
double-clicking on ‘Review’ and ‘Today’, you can list all the employees who need to be reviewed 
today. 

Click [Views] to display the Note Codes View. 

Corporate Notes View 

The Corporate Notes view provides a calendar-based view of note code events for the whole 
company.  The green, red, and yellow color bars visible in the year view can be changed as 
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desired. 

To change views, press [Year], [Month], or [Day]. To view a specific month or day, select it 
before changing view. 

To change the notes shown, select [Note Colors] from the year view, and pick the desired note 
code from the green, yellow, and red list boxes.  Save and press [Recalculate]. 

To narrow the location shown, press [Change Location] and select the location desired.  Note 
that a specific division cannot be specified below an “all locations” selection.  For example, if 

Redmond is the selected branch, and all departments is specified, then all areas and all teams are 
included without option.  To narrow down to a specific team, the branch, department, and area 
must be specified. Save and press [Recalculate]. 

Corporate Status Code Summary 

The Status Code Summary gives totals of all employees by their status.  This view shows how 
many employees have been hired this month, hired this quarter, hired this year, and employees 
who ended this month, ended this quarter, ended this year, and a total of all employees, all within 
a particular status code.  Use this view to display how many full-time, part-time, temporary, etc., 
employees you have in your organization (or your current location).   

If you want a list of the employees who have a particular status, double click on any row and 
column to show a list of employees.  For instance, by double-clicking on the row ‘Full time 
employees’ and the column ‘Hired this quarter’, you can list all the employees who are full time 
and were hired this quarter. 

Organization Chart View 

The organization chart view displays a hierarchy based on the locations entered in each 
employee’s record.  The Branch, Department, Area, and Team are displayed graphically to show 
where employees are located in your organization.  To change the location of an employee, edit 
the Employee Location from the Employees folder. 

To view the employees in a location, click the location in the organization chart on the left side of 
the page.  The right side of the page lists all employees in the selected location.  Double-click the 
employee to jump to their record. 

Corporate Statistics View 

The Corporate Statistics View displays overall totals for the company (or selected location).  Use 
this view to display the total number of employees, employees who have expired Work Permits, 
I-9 forms, and a breakdown of the notes and Performance.  Use Statistics in the Corporate Policy 
folder to set the periods at which these statistics are calculated.   

Click [Refresh] to refresh the information in the view in case records have been added or updated 
by other users in a multi-user environment. 
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Corporate Policy Folder 
Corporate Policy contains the general company setup, such as jobs, locations, note codes, 
benefits, and associated information. The following options and tools appear in the Corporate 
Policy folder: 

� Company Information 
� Organization Chart 
� Note Codes 
� Benefits 
� Time-off Benefits 
� Job Categories 
� Jobs 
� Statistics Setup 

To open this folder, click on the /Corp Policy\ folder tab. 

Company Information 

To change the default company information, click [Edit] at the bottom of the folder, or click on 
any of the fields displayed and enter the appropriate information in each field.  The Company 
Name field displays at the top of each report.  The other information may be used for other 
reports or just for your reference.  When finished entering data, click [Save]. 

Organization Chart 

The Organization Chart in the Corporate Policy folder provides an editable visual tool for 
maintaining employee divisions and hierarchy.  Divisions are shown by branch, department, area, 
and team.  Employees may be assigned to any level created, allowing management positions to be 
assigned directly to a branch, department, area, or team.  The information entered in the 
organization chart is used to assist in assigning locations to employees. 

To make changes to the Organization Chart, press [Add], [Edit], or [Delete]. 

Add/Edit 

Note:  This chart does not show individual employees; these are visible in the Corporate Views 
Organization Chart. Employee locations must be entered into each employee’s record just as they 
are assigned a job, in order to maintain consistent data throughout EmployeeFileBuilder. 

Add/Edit Organization Chart 

To add a new level to the organization chart, click on the next level up from the one being added.  
For example, if a new department is to be added to the South Carolina branch, click on South 

Carolina, then [Add].  To edit, click on the level to be edited, then [Edit]. 

In the Add/Edit Location screen, enter the desired information.  If adding a new location, enter 
the names in the blank fields as they should appear on the chart.  Click [Add] to create a new 
location, even if identical to another location on a different branch of the chart.  Click [Edit], or 
double-click on the location to make location changes.  Changing any of the fields will effectively 
move the location in the chart. 

Note Codes 
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Note Codes are abbreviations for common events that are date-specific, such as lateness, 
absenteeism, medical or dental appointments, or vacation days.  Codes for these events and 
periods might be L (late), AB (absence), MD (medical), or V (vacation) respectively. 

In day-to-day use, recording of such events only requires the user to specify a note code and a 
date, when an entry needs to be made in an employee’s file.  Extended details may be recorded 
with the note, but are not essential. 

Add/Edit Note Code 

Add/Edit Note Codes 

To add or edit a note code definition, press [Add], or select a note and press [Edit].  Enter a short 
code and description in the marked fields.  Select whether the note code event will extend over a 
multi-day period, and/or is excused, such as a vacation.  The excused option enables notes to be 
displayed in either green or yellow from within the Views button in the Employee Notes page as 
well as the Notes View button in the Corporate Notes Summary page.  If an extended description 
is needed, enter it in the comment box, and press [Save]. 

Note:  a note code that is marked as excused does not necessarily create a ‘carte blanche’ 
situation whereby, for example, an employee’s vacation would appear as excused even though 
there was an extra week taken off. 

Benefits 

Benefits are tracked in a simple list, showing the benefit, code, dates, and description.  This list 
shows all benefits available through the company.  Once a benefit is defined, an employee may be 
given the benefit through their Employee folder record. 

Edit Corporate Benefits 

Edit Corporate Benefits 

To add a benefit to the list, press [Add Benefit].  To edit an existing benefit, select it and press 
[Edit Benefit].  Enter a code and a benefit name or short description.  Set the period after which 
the employee is eligible for the benefit, and how long the benefit continues after termination (for 
example, health coverage may continue under COBRA rules).  These settings will affect the 
eligibility date when the benefit is assigned to an employee. 

Any details or additional description may be entered in the comments field.  Press [Save].  To 
assign the benefit to a specific employee, do so in the Employees folder. 

Time-off Benefits 

The policies concerning time-off for employees can differ from one company to the next.  
EmployeeFileBuilder has been designed to accommodate a wide variety of time-off policy 
situations to ensure accurate accrual and administration for all companies.  We have provided an 
explanation of the options involved as well as an example of how to define a time-off policy. 

From within the Corp. Policy folder, select the [Time-off Benefits] page located on the right side 
of the screen.  The Time-off Benefits screen will appear showing you the Code, Description, and 
Comments of the benefits available.  You’ll notice EmployeeFileBuilder already offers a number 
of predefined time-off benefits for your convenience.  Feel free to edit and use them as you wish. 
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From within the Time-off Benefits page, select the [Add] button located on the bottom of the 
screen.  This will display the add time-off benefit wizard window. 

Add Time-off Benefit 

On the first page, enter a unique benefit code to identify the new time-off benefit, a short 
description, and enter any additional comments as needed in the spaces provided.  ‘Click’ the 
[Next>] button on the bottom of the screen to advance to the second page of the Add Time-off 

Benefit Wizard. 

The second page of the Add Time-off Benefit Wizard allows you to enter the time periods of 
this new benefit, and if it’s going to be tracked in days or hours. 

First, enter the length of time before the benefit starts.  The first field available after the Benefit 

starts is a numeric field to be used in conjunction with the drop-down menus that follow.  The 
second field’s drop-down menu has 4 choices: Day(s), Month(s), Quarter(s), and Year(s).  The 
third field provides 3 choices: Hire Date, Start Date, and Today.  For example, a Benefit starts 2 

months after Hire Date. 

Note:  If you choose Start Date the benefit will calculate time off from the employee’s most 
current job start date.  If Hire Date is chosen the calculation will begin from the date you hired 
the employee.  Both dates can be found in the lower right-hand corner of the Main Form page in 
the Employees folder. 

Next, select the period for the benefit.  The Benefit Period field provides 3 options: Quarter, 
Anniversary Year, and Calendar Year.  If Quarter is selected, the benefit renews itself on the first 
day of each quarter on a calendar year basis.  If Anniversary Year is selected, the benefit renews 
itself on the anniversary of the employee’s hire date.  If Calendar Year is selected, the benefit 
renews itself on January 1st of each year.  

Now enter the units used to calculate the time-off benefit.  The Benefit is to be calculated in units 

of field provides 2 options: Hours and Days.  If Hours is selected, accrual will be based on note 
code hours, otherwise, note code Days will be used.  You will want to build your policy based on 
Hours if the company policy allows partial days-off, and in Days if your policy is for full days 
only.  Most commonly, days are translated into 8 hour blocks. 

Select the [Next>] button to continue with the third Add Time-off Benefit Wizard screen, or 
select the [<Back] button to make a correction to this new time-off benefit. 

The third page lets you select the note code(s) that will be used to calculate the time-off benefit.  
By doing this, the program will be able to process the information needed for an employee’s 
record when a note code is selected (i.e.  An employee who takes a vacation day will have 1 day 
of vacation time taken away from their accrued vacation time).   

Select the note code(s) that will be used to calculate the time-off benefit by placing a “check 
mark” to the left of the note code.  There may be an instance in which two or more note codes 
might update one policy.  For example, placing check marks to the left of the D and the S would 
be appropriate if you track dental appointments separately, but subtract them from accumulated 
sick time. 

Note:  When a note code is selected for more than one time-off benefit it will deduct time from 
each benefit.  When an employee has a note code applied to them for a particular occurrence, it is 
possible for it to deduct time from two or more time-off policies. 

When finished, select the [Next>] button to continue with the final Add Time-off Benefit 

Wizard page, or select the [<Back] button to make a correction to any portion of this new time-
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off benefit. 

The final Add Time-off Benefit Wizard page lets you enter the types of calculations that will be 
used for each period of the new benefit. 

Notice the Benefit Period field automatically defaults to the 1st benefit period (Quarter, 

Anniversary Year, or Calendar Year) that you have defined in the second Add Time-off Benefit 

Wizard page.  Initial calculations need to be entered here.  If the calculations of this new benefit 
you are creating change over a period of time, like after 3 years of employment, ‘click’ on the 
[Next Period>] button to move to future benefit periods.  For example, let’s say you’re creating a 
vacation time-off policy for employees that provides them with 2 weeks of vacation per year for 
the first 3 years of employment.  However, this vacation policy will give them 3 weeks of 
vacation after they have been with the company for 4 years.  Instead of creating two separate 
time-off benefits, you can set up the calculation on this page.  Enter the appropriate calculations 
into the 1st Benefit Period, then ‘click’ on the [Next Period>] button to move to the 4th Benefit 
Period to calculate the 3 weeks of vacation. 

The first field underneath the Benefit Period allows you to input an initial quantity of time that is 
given at the start of the period.   

Note:  You may want to assign an opening balance at the time you assign a time-off benefit to an 
employee in their Time-off Benefits page in the Employees folder. 

The next field will allow you to establish how much time an employee can bring forward from a 
previous benefit period.  If your organization lets employees bring forward unused vacation time, 
for instance, this is where you would define how much unused time is allowed. 

If the time-off benefit you are creating includes a time accrual structure, ‘click’ a “check mark” 
on the Use Accrual box to activate the set up fields for this option.  Enter a time unit in the first 
field and enter the time period in the last two fields.  For example, Accrue 6.7 Hours every 1 

Month(s).  Notice how the parameters you set in the second Add Time-off Benefit Wizard 
screen are shown (i.e. Hours or Days). 

Next, enter the maximum amount of time-off units that will be allowed per benefit period.  This 
field allows you to put an “absolute cap” on the amount of time an employee can have available 
for this benefit.   

Now that you have set up the calculations for the 1st Benefit Period, ‘click’ the [Next Period>] 
button to the desired Benefit Period if you need to change the time-off calculations in future 
periods (as mentioned above).   

If everything is in order, select the [Finish] button to add this new time-off benefit to your list of 
available Time-off Benefits in your Corp. Policy folder. 

Here is one time-off scenario to help get you started: 

In our scenario, we’ll set up an employee vacation policy.  Full-time employees will receive 
vacation credits that equal 6.7 hours per month (the equivalent of 2 weeks a year) for the first two 
years of employment, and then 13.4 hours per month (the equivalent of 3 weeks a year) from the 
start of the third year and thereafter.  The employee’s vacation credits, however, do not start 
accruing until the second month of employment.  While they can bring forward up to 40 hours of 
unused time from one year to the next, the total accumulated hours cannot total more than 160 
hours (one month’s work). 

To create this scenario follow these steps: 

1.  Enter the Corp. Policy folder and ‘click’ on the Time-off Benefits page.  ‘Click’ on the [Add] 
button, and enter the descriptions for the vacation policy in the first Add Time-off Benefit 
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Wizard page.  When finished, ‘click’ on the [Next>] button. 

2.  On the second page, indicate the time calculations for the policy.  For our example, the benefit 
starts 30 days from the employee’s Hire Date.  So our Benefit starts field should read as follows: 

Benefit starts 1 Month after Hire Date.   

The Benefit Period is next.  Since our scenario is based on a yearly accrual basis from the hire 
date of employment, the Benefit Period should read as follows:  Benefit Period: Anniversary 

Year. 

Now the units used to calculate the time-off benefit needs to be defined.  Since our scenario is 
using an hourly accrual structure, the benefit calculation should read as follows:  Benefit is to be 

calculated in units of: Hours.  When finished, ‘click’ on the [Next>] button. 

3.  On the third page, indicate the note code(s) that will be used to calculate the time-off benefit.  
Since our scenario is a vacation policy, place a “check mark” on the left-hand side of the “V” (for 
vacation).  We are only selecting “vacation” because no other note codes will take time away 
from this particular benefit.  When finished, ‘click’ on the [Next>] button.   

4.  On the final page, enter the calculations used for each benefit period.  For our scenario, enter 
the following information into the default Benefit Period: 1st Anniversary Year screen:  

An initial quantity of 0 Hours are given at start of benefit period. 

There isn’t an initial amount of hours given in this example. 

Bring forward up to 40 unused Hours from previous Anniversary Year. 

This is the maximum quantity of unused time the employee gets to bring forward from a previous 
year. 

X Use Accrual 

 Accrue 6.7 Hours every 1 Month(s) 

Our scenario allows 2 weeks a year (10 days) of vacation for the first 2 years of employment. 

A maximum of 160 Hours are allowed per Anniversary Year. 

Our benefit will not let the employee’s accumulated hours surpass 160 hours. 

Now we need to set up the benefit for the time-off accrual after the employee has been with the 
company for 3 years.   

‘Click’ on the [Next Period>] button “twice” until the Benefit Period reads as follows:  Benefit 

Period: 3rd Anniversary Year.  Now, fill out the fields with the appropriate information. 

An initial quantity of 0 Hours are given at start of benefit period. 

There isn’t an initial amount of hours given for this benefit period. 

Bring forward up to 40 unused Hours from previous Anniversary Year. 

Nothing has changed here from the 1st Anniversary year. 

X Use Accrual 

 Accrue 13.4 Hours every 1 Month(s). 

Our scenario allows 3 weeks a year (15 days) of vacation when the employee has worked for the 
company 3 years. 

A maximum of 160 Hours are allowed per Anniversary Year. 
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Nothing has changed in this field from the 1st Anniversary Year.  

Now select the [Finish] button to add this vacation time-off policy to your Time-off Benefits 
page in your Corp. Policy folder.  You are now ready to start assigning this benefit to individual 
employees. 

Edit Time-off Benefit 

From within the Time-off Benefit page, ‘click’ on the benefit you want to edit and select the 
[Edit] button located on the bottom of the screen.  Then follow the same instructions defined in 
the add time-off benefit wizard. 

Job Categories 

All job categories in the company are defined in the Corporate Policy folder Job Categories page, 
and are listed alphabetically by Job Category.  Each job must have a job category.  To add a new 
job category click [Add]. To edit a job category, select the job category in the list and click [Edit] 
or double-click the job category. To delete a job category, select the job category in the list and 
click [Delete]. 

Jobs 

All jobs in the company are defined in the Corporate Policy folder Jobs form, and are listed 
alphabetically with basic information visible.  Jobs can be broken down into job categories. 

To add or edit a job in the list, press [Add] or [Edit]. 

Add/Edit Corporate Job 

Add/Edit Corporate Jobs 

To add or edit a corporate job definition, press [Add] or [Edit].  Enter the desired job title, make 
up a unique job code, and select a category under which this job falls. 

Entry of job code, category, pay period, status and salary are required.  Enter a clearance level 
and notes (job description) as necessary.  This information forms the default starting point for 
employees given this job, but may be modified at any point for a particular employee.  Press 
[Save] when complete. 

Corporate Statistics Setup 

Corporate Statistics Setup sets the periods at which the Statistics view is calculated.  Set the 
quantity and the period for performance entries and notes to be updated, and expiration checks for 
work permits, and I-9 forms.  For instance, you can set the expiration for work permits to 3 weeks 
from today and then run the Corporate Statistics view to show how many employees will have 
expired work permits in 3 weeks. 

Edit Statistics Setup 

Edit Corporate Statistics 

To define how the statistics will be calculated and presented to you, select the [Edit] button 
located on the bottom of the Statistics Setup page.  Enter the desired update times of 
Performance Entries and Employee Notes and input the desired times for your expiration 
reminders.  Utilize the drop-down menus in each field to consistently input your information.  
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‘Click’ the [Save] button to activate the changes.   

 


